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6 ANALYZING 2D SCAN DAT A 

Once a scan has been completed, the computer processes the measurement data and 
displays it in the Data Analysis window. This chapter discusses how information is 
presented in the Data Analysis window and how to analyze and manipulate the data. 

This chapter describes 

• Parts of the Data Analysis window 

• Leveling the data 

• Using the measurement cursors 

• Using Feature Detection 

• Using cutoff filters on the data 

• Radius measurements on curved surfaces 

• Saving and maintaining data 

6.1 DATA ANALYSIS WINDOW 
When a scan is completed, the Data Analysj.s window appears: 
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Figure 6-1 2D Data Analysis Window 
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You can also review previously saved data in the Data Analysis window. 
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6-2 Tencor P-20h Operations 

To review previously saved data: 

1. From the Database Catalog window, select Scan Data. The Scan Data Catalog is 
displayed: 

Scan Data Path: 

Drive: 

1 liilc= 

•• 2DSCAN1 JE0_33 

Figure 6-2 Scan Data Catalog Window 

• JE0_248 TST265 

Ill 

2. If necessary, click on the 2D or 3 D button ( or choose 2D and 3 D in the File menu) 
to display the catalog desired. 

3. To select and open a data set, use either of the following methods: 

• Click on the Thumbnails button to display small graphical representations of 
each data set. Then click first on the thumbnail desired, then on OK to open the 
file. You can also double-click on the thumbnail to open the file. 
or 

• Click on the name of the desired data set in the list, and then click on the Review 
button below the list, or double-click on the name of the desired data set. 

The Data Analysis window appears with the selected data set displayed. 

6.1.1 DATA ANALYSIS MENU BAR 
The Data Analysis menu bar provides the following menus. You can view menus by 
clicking on the titles in the menu bar, or by pressing ALT+ l, where l is the letter that 
appears with an underscore in the desired title in the menu bar. You can choose menu 
items by clicking on a menu entry or by typing the letter that appears with an underscore 
in the desired menu item. 
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Figure 6-3 Fi!e Meou 

Figure 6-4 Trace Menu 

Figure 6-5 Parameters Menu 

Figure 6-6 Operations Menu 

Figure 6~7 Window Menu 
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6-4 Tencor P-20h Operations 

6.1.2 DATA ANALYSIS TOOL BAR 
The Data Analysis tool bar contains a row of icons that resemble buttons. Clicking on 
these buttons provides an alternative way to access commonly used functions. Each icon 
suggests the function of the button. Buttons that appear dimmed are unavailable. 

The Data Analysis tool bar contains the following buttons. 

Button Action 

Returns scan plot to original scale from zoomed in view. 

Activates cursors for selecting a scan segment for magnification. 

Toggles between the Measurement and Leveling cursors. 

Switches focus to the Surface Parameter Summary window. If the Surface 
Parameter Summary window is currently minimized, it appears maximized 
upon clicking this button. 

Toggles display of normal trace. 

Toggles display of waviness trace. 

Toggles display of roughness trace. 

Activates Fine Movement Mode. 

Displays the Print dialog box. 

6.2 DATA LEVELING AND MEASUREMENT 
This section discusses leveling and measurement of the scan data. Data leveling completes 
the adjustment begun by the mechanical leveling of the stage performed prior to the scan 
(Section 5.7, "Leveling the Stage"). 

To accurately measure anything, you need to have a sensible frame of reference. For 2-D 
scan data, this amounts to indicating two points along the scan that are at equal heights. 
These two points define a reference axis for plotting the data and calculating surface 
parameters. 

In the Tencor P-20h Data Analysis window, the two points are indicated by using two 
pairs of vertical lines called the leveling cursors. The initial position of the leveling cursors 
is set in the recipe, but you are free to reset their positions at any time after the scan is taken. 

Each 2D cursor, measurement or leveling, consists of a pair of vertical lines that can be 
expanded to define a region. The average value of the height within the region is then used 
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for measurement and leveling. For best results on rough or noisy scans, you should expand 
the cursors to cover a wider region. 

Often you can determine acceptable leveling cursor positions in advance by viewing a 
sample in the XY View window prior to finalizing the recipe and scanning. However, it 
is not always obvious, or ym1 might accidentally set them at inappropriate locations. In an 
extreme case, the left leveling cursor might be at the bottom of a large step, and the right 
leveling cursor on the top. Using these two areas to define a reference axis, the plotted 
data looks something like the following figure. 

Recipe: STYLCALB Level; 0 • Length: 923 µm 
Speed: 50 µm/sec Meas: I 
Direction-> 80•.4, Repeats: 1 
Force: 15 mg 

Cursors 
100A 

Left Righi 
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Level -21'3.0 244 .0 
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Rel: 219,0 
Helgtt -155.3.!. 

400.!. 
dlh: 922.0 IJIII 

TIR: 9QQ.7.l 

300A 
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Figure 6-8 Data Before Leveling 
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6-6 Tencor P-20h Operations 

Fortunately, you have complete control of the leveling cursors, so you can readjust them 
until they indicate two points that are at the same height. Then you have the computer 
replot the data with these new positions, and the result is sometbing like the following 
figure. 

Recipe: STYLCALB 
Levet Length: 923 µm 

Speed: 50 µm/seo Mees: I 
O.ection -> 

eooA Repeats: 1 
Force: 15 mg 

Cursors 110A 

Left Rli;,t 
Meas -219 .0 703.0 

s20A Delta -218.0 704.0 
level -201 .0 443.0 
Delta -173.0 512.0 

530A 

Ref: 219.0 
Height 17.7 A 

440A 
h: 922.0 µm 

TIR: 793.eA 

JS0A 

2soA 
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80/1. 

-1oA 

.100A 
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Scan Length (IJm) 

Figure 6-9 Data After Leveling 

This Data Analysis window can now provide you with some meaningful measurements. 
Again, you need a way to indicate to the computer what you want to measure. For example, 
if you want to know the difference in height between two points, you need to be able to 
indicate those two points to the computer. 

This is accomplished using another set of vertical lines, the measurement cursors. The 
Data Analysis window appears with the measuring cursors set at the locations specified 
in the scan recipe. 

Like the leveling cursors, the measurement cursors can be freely moved to any position. 
The displayed parameter values are recalculated whenever the measurement cursors are 
moved to new locations. 
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To set leveling or measurement cursors: 

The measurement cursors normally are active unless you have selected the leveling cursors 
to level the scan. Reactivate the measurement cursors by clicking on LEVEL in the tool bar. 

1. To set the leveling cursors, select Level Trace from the Operations menu, or click 
on LEVEL in the tool bar. This activates the leveling cursors. They are at the locations 
currently specified in the recipe, with the left cursor selected. 

To reactivate the measurement cursors, use Level Trace or LEVEL as above. 

2. Press [ <] or [>] or use the trackball, with cursor on the bar or inside the pair of lines, 
to move the left cursor to the desired position. 

3. To adjust the width of the cursor: 

• Place the cursor near and outside of the line to be moved. 

• Click and drag to the new position. 

4. Repeat steps 1 through 3 with the right cursor. You can also move the cursors in 
tandem: 

• Press the space bar until both cursors are selected. Use the arrow keys to position 
them. 

If you need finer cursor control, select Fine Movement Mode from the Operations 
menu or click on its icon in the tool bar ( a miniature scan trace). Press [<] or [>] to 
position the cursor pair. 

5. To level the scan: 

• Once the cursors are positioned as desired, select Level Trace from the Opera
tions menu, or click on the Level button in the tool bar. The data is leveled and 
replotted. The leveling cursors become inactive and the measurement cursors 
become active, 

To measure: 

• Set the measurement cursors on the desired features. The parameter values are 
displayed in the Trace Information area to the left of the scan. 

If desired, you can replace the cursor positions stored in the recipe with the new positions 
of the cursors. 

To save the current cursor positions in the Scan recipe and update the data in the 
Surface Parameter Summary window: 

Choose Recalc with Unzoomed Level Cursors from the Operations menu. 

To zoom in on selected features: 

1. Click on Zoom In on the tool bar or choose Zoom In from the Operations menu. 
Two vertical lines appear on the scan. 
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6-8 Tencor P-20h Operations 

2. Ignore the two lines and position the cursor to one side of the feature you want to 
enlarge. 

Click and drag the cursor across the feature. The two vertical lines reappear, one at 
the starting point and one that follows the cursor as you drag it. 

3. Click again to drop the second cursor at your ending point and to zoom the scan. 

You can also position the vertical lines with the arrow keys. Pressing the spacebar 
zooms the scan. 

Note: For finer positioning, select Fine Movement Mode from the Operations menu 
or click its icon on the toolbar (a miniature scan trace). Press[<] or[>] to position 
the vertical lines. 

4, Return to the original scan view by clicking on Undo Zoom or select Undo Zoom 
from the Operations menu. 

5. To update the data in the Surface Parameter Summary window and to enter new 
leveling cursor positions in the recipe, select Recalc with Zoomed Level Cursors 
from the Operations menu. 

XY View Parameter Values 

Meas 

Delta 

Level 

Delta 

Ref 

Height 

Width 

TIR 

X-axis value of the left vertical line of the selected measurement 
cursor. 

X-axis value of the right vertical line of the selected measurement 
cursor. 

X-axis value of the left vertical line of the selected leveling cursor. 

X-axis value of the right vertical line of the selected leveling cursor. 

Scan position reference point designated in the recipe. 

Difference between the average height of the scan region marked by 
the right measurement cursor and the average height of the scan 
region marked by the left measurement cursor. 

Difference between the average X value of the scan region marked 
by the right measurement cursor and the average height of the scan 
region marked by the left measurement cursor. 

Total Indicated Runout. The difference between the highest and the 
lowest points on the scan. 
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6.3 USING FEATURE DETECTION 
Consider a situation where you wish to compare the step heights from ten different 
instances of an artifact on a sample. It is difficult without taking extra care to start each of 
the ten scans at precisely the same location relative to the artifacts.. Typically, the 
measurement Cl!fSOr settings from the first scan will not precisely compare to the same 
locations relative to the feature on the subsequent scans. Therefore, you need to manually 
adjust the measurement cursors for each scan. This can be tedious and introduces some 
imprecision into the comparison, since it is difficult to locate the cursors manually in 
exactly the same way for all the scans. 

Feature Detection makes it possible to automatically and reliably set the position of the 
measurement cursors relative to the rising or falling edge of a steplike feature, or the apex 
of an arclike feature. For each instance, then, you need not worry that you are starting the 
scan at precisely the same distance in front of each of the artifacts. This eliminates the 
need to manually adjust the cursors for each scan, facilitating comparison between two or 
more instances of an artifact. 

Both the location of the edge ( or the apex of an arc) and the step width can be calculated 
and displayed in the Data Analysis window. 

For steplike features, Feature Detection distinguishes between rising or falling edges. 
Since steps are rarely perfectly vertical, Feature Detection also distinguishes between two 
types of edges. The following convention is used: the location at the top of the slope is 
called the edge, and the location at the bottom of the slope is called the base. The following 
figure shows this convention for a plateau and a valley. 

Up Edge 

-1j-----~ 
I 

j 
' 

UpBase 

Figure 6-10 Edges of a Step 

Down Edge 

------.:•-~-----: 
: 
l 

DownBase 

Feature Detection also distinguishes between convex (hill-like) and concave (valley-like) 
arcs (Fig 6-11). 
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Apex 

Apex 

Convex Arc + 
Concave Arc 

Figure 6-11 Convex and Concave Arcs 

Feature Detection parameters are configured in the Recipe Editor window: 

Feature Detection 

Feature: 

Feature Number: 

Slope Threshold: 110. 

Plateau Threshold: 110. 

Min. Plateau Width: 110. 

Figure 6-12 Feature Detection Dialog Box 

You must set several values to specify the type of the step edge or apex feature that you 
are measuring. A description of these values follows. 

Feature 
The Feature field identifies the type of feature to be detected, or turns Feature Detection 
off. The selection box has seven possible choices: 

• None (no Feature Detection) 

• UpEdge (rising edge) 

• DownEdge (falling edge) 

• UpBase (rising base) 

• DownBase ( falling base) 

• Convex (hill-like arc) 

• Concave (valley-like arc) 

If None is selected, the remaining fields in the dialog box are unavailable and appear 
dimmed. 
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Click anywhere in the selection box and click on the desired item in the list or double
click in the selection box and type the first letter or letter of the desired item in the list. 

Feature Number 
If there are multiple edges detected in a scan, Feature Number provides a way to select a 
particular edge for detection. Detected edges are numbered sequentially from 1 to n. 

Slope Threshold 
This factor sets the value at which an upward slope in the trace is considered to be preceding 
the step height edge or apex; that is, when an upward slope appears that rises significantly 
above the general roughness of the surface. 

Valid values range between 0-50.000. When the artifact is much larger in comparison to 
the surrounding roughness of the surface, set the value higher. If the artifact is only a little 
larger than the surrounding roughness, set this value lower .. Note that in this case, you 
might also need to set the Minimum Plateau Width (description follows) to avoid any 
ambiguity. 

The concept of the Slope Threshold is very similar to a signal-to-noise ratio. The best 
values for a given sample will depend on the relative scales of the artifact that you are 
examining and the surrounding surface roughness, as well as parameters such as scan 
speed, sampling rate, and so on. You might need to experiment to find appropriate values 
for Slope Threshold. The default values of 5.000 (for a step) and 1.000 (for an apex) are 
sufficient for most scans above 200A. 

Click in the Slope Threshold field and type the desired value. 

Plateau/Apex Threshold 
This factor affects the precise horizontal location calculated for the edge or arc. Since the 
edge of a step is rarely a perfectly defined location, this factor allows you to adjust the 
value to the left or right, depending on whether you consider the edge to be the bottom of 
the step, the top of the step, or somewhere in between. 

For an edge, set this value to about the same value as the Slope Threshold. Valid values 
range between 0-50.000. Setting this threshold slightly greater than the Slope Threshold 
will move the precise location of the edge slightly to the left for an UpEdge or to the right 
for a DownEdge. Setting this threshold slightly smaller than the Slope Threshold will move 
the precise location of the edge slightly to the right for an UpEdge or to the left for a 
DownEdge. For UpBase and DownBase, the adjustment is the reverse. For a Concave or 
Convex arc, set this value to a very small number, between 0-1.000. You might need to 
experiment to find appropriate values for Plateau/ Apex Threshold depending upon the 
relative scales of the artifact that you are examining and the surrounding surface roughness. 
The default values of 5.000 (for a step) and 0.000 (for an arc) are sufficient for most scans 
above 200A. 
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NOTE: The Slope Threshold determines whether or not an edge is detect
ed; the Plateau/Apex Threshold determines only the precise report
ed location of a detected edge. 

Click in the Plateau/ Apex Threshold field and type the desired value. 

Minimum Plateau Width 
This value specifies the minimum horizontal length between a rising and falling edge, used 
in the feature detection calculation to determine the correct edge. This is useful in cases 
when the roughness of a surface might be large enough that it becomes difficult to adjust 
the Slope Threshold to find the correct feature without ambiguity. In such cases, narrow 
roughness peaks can extend above the height determined by the Slope threshold without 
causing the algorithm to identify them as the edge. 

For steplike features, the Minimum Plateau Width specifies a plateau as follows: 

• For ascending features (UpEdge; UpBase), the plateau is the one following the 
detected edge. 

• For descending features (DownEdge, DownBase), the plateau is the one preceding 
the detected edge. 

Slope Threshold 
determines minimum 
height for an edge to 
be identified ... 

~---

. .. but if surrounding noise is large enough, a stray 
noise peak might be mistakenly identified as the 
edge unless Minimum Plateau Width is set to a 
value wide enough to reject stray noise peaks, but 
narrow enough to avoid rejecting the feature. 

Figure 6-13 Feature Detection and Minimum Plateau Width 
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The Minimum Plateau Width can be used to reject such peaks that may otherwise cause 
failure to detect the correct edge. For UpEdge, DownEdge, UpBase, or DownBase 
features, set this value to be greater than the width of stray peaks, but always slightly less 
than the width of the step to be detected. Set this value to slightly less than the step width. 
Setting it too high will result in no edge being found. Valid values are in the range 0.005-
1000.00 µm (0.0002-39.3701 mil). 

NOTE: Minimum Plateau Width is not intended for use with Concave or 
Convex features. In cases of rough sample surfaces, though, it 
might be useful. For a Convex arc, the Minimum Plateau Width 
specifies a minimum width for the feature, and so can be used to 
reject narrow roughness peaks in the vicinity of the arc. For a 
Concave arc, the Minimum Plateau Width is used to specify a 
minimum size for a level section following a detected arc. 

Click in the Minimum Plateau Width field and type the desired value. 

When Feature Detection is enabled, the following General Parameters are interpreted as 
follows. 

Edge (Distance to Edge) 
Depending on the setting of the Slope Threshold and the Plateau/ Apex Threshold, this 
distance is either 

• The distance between the beginning of the scan and the first rising or falling edge 
or base of a step; or 

• The distance between the beginning of the scan and the apex of the first convex or 
concave arc. 

StpWt (Width of Step) 
The width of a step plateau; that is, the distance between the leading and trailing edges of 
the plateau. The Stp Wt value does not apply in the case of an arc. 

NOTE: It is important that you can use the Feature Detection calculation 
reliably if you have set the thresholds appropriately for the partic
ular type of feature you are scanning. Also note that the profile scan 
length must be long enough that the artifact is completely included, 
and that there is enough scan data on either side for the leveling 
cursors to be set reliably. 

The following figures (Figs. 6-14 through 6-16) demonstrate the usefulness of Feature 
Detection. The three scans were taken across the same section of the artifact, but the scans 
began and ended at different points along the profile. 
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Figure 6-~4 Scan 1 With Feature Detection Enabled 
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Figure 6-15 Scan 2 with Feature Detection Enabled 
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Figure 6-16 Scan 3 with Feature Detection Enabled 

6.4 USING CUTOFF FILTERS 
The Tencor P-20h scan data does not come directly from the sensor, but instead is filtered 
through three stages: 

• an analog hardware filter 

• a digital decimation filter 

• digital software filtering 

The sensor output is filtered by the analog hardware filter so that it can be digitized with 
minimal distortion. The filter also reduces noise by attenuating higher frequencies. It has 
a fixed cutoff frequency of 18 Hz .. 

The signal then passes through an analog-to-digital (AID) converter. The AID converter 
has a nominal sampling frequency of200 Hz (100 Hz at the 1 µmis and 2 µmis scan speeds). 

Next, the signal passes into the digital decimation filter. This step is necessary to reduce 
the signal sampling rate from the original 200 Hz (or 100 Hz) down to the sampling rate 
selected in the recipe by the user. If you select the maxjmum sampling rate in the recipe, 
no decimation is done. 

Along with reducing the sampling rate, the decimation filter also affects the cutoff 
frequency of the scan data. At 100 Hz, the cutoff frequency is not significantly reduced, 
but at 50 Hz, the cutoff frequency is reduced to 14 Hz. 
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The cutoff wavelength depends on the scan speed as described by the following equation: 

Scan Speed CutojfWavelength = ______ ...;,_ ____ _ 
Cutoff frequency of combined filters 

For example, with a scan speed of 100 µmis, and a sampling rate of 200 Hz or 100 Hz, 
the cutoff wavelength is 5.6 µm. With this same scan speed, however, at a sampling rate 
of 50 Hz, the cutoff wavelength is 7 .1 µm. 

The action of a cutoff filter can be illustrated by plotting the percentage of signal 
transmission as a function of wavelength (usually plotted as the logarithm of wavelength). 
Note that there is always some slope in the transmission curve of a cutoff filter; that is, 
the transmission percentage is not exactly zero for all values on one side of the cutoff value 
and exactly 100 for all values on the other side of the cutoff value. The cutoff wavelength 
of a filter is defined by that wavelength at which 50% of the signal is passed. 

The following figure shows the transmission curve of the combined analog and decimation 
filters. For every factor of 10 in scan speed, the curve moves to the right by a factor of 10 
in wavelength. 
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Figure 6-17 Effect of the Analog Filter and Decimation Filter on Signal Transmission 

Two adjustable software cutoff filters-5hort wave and long wave-allow you to control 
the range of wavelengths collected in your scan data. You might wish to filter data to 

• reduce the effect of small surface irregularities or environmental noise 

• remove large-scale waviness and form error so that roughness can be evaluated 
unambiguously 

• isolate specific frequency bands, allowing determination of intermediate compo
nents of roughness or waviness 
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The short wave cutoff(or long wave pass) filter, as the name implies, cuts off the short 
wavelengths in the data (those below the filter's cutoff value), passing the longer wave
lengths. 
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Figure 6-18 Effect of the Short Wave Cutoff Filter 

Conversely, the long wave cutoff ( or short wave pass) filter cuts off the higher wavelengths 
in the data (those above the filter's cutoff value), passing the shorter wavelengths. 
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Figure 6-19 Effect of the Long Wave Cutoff Filter 

The P-20h gives you a choice of two kinds oflong wave filters: Gaussian, for Windows
based systems; and RC, for data files comparable to those obtained with DOS-based 
systems such as the Tencor P-2 Long Scan Profiler. 

You can use the long- and short wave filters separately, or together to form a band pass 
filter that cuts off all short wavelengths below the short wave cutoff value and all long 
wavelengths above the long wave cutoff value. Note that the software will not allow setting 
a short wave cutoff that is larger than the long wave cutoff, which, of course, would result 
in a zero-width band of wavelengths, attenuating all of the data. 
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Figure 6-20 Defining a Pass Band with the Short Wave and Long Wave Cutoff Filters 
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To set the short wave filter cutoff values: 

1. From the recipe window, click on Filters/Cursors to open a dialog box. 

2. Tab to the Noise entry field to enter a wavelength (in µm), or click on the drop-down 
arrow to choose a value from the range of cutoff filters provided. You can also turn 
off the filter. Selectable values are listed in Table 6-1 . 

Table 6-1 Short Wave Cutoffs 

µm mil µm mil mm mil 

Default1 - 14 .56 1.4 56 

0.25 .01 25 1.0 2.5 100 

0.45 .02 45 1.8 4.5 180, 

0.80 .03 80 3.0 8.0 300 

1.4 .06 140 5.6 14 560 

2.5 .10 250 10.0 25 1000 

4.5 .18 450 18.0 - -

8.0 .30 800 30.0 - -

1Refer to Table 6-2 for default short wave cutoff values. 

Up to 22 possible settings (including the default) are available depending on the scan speed. 
You are prevented from mistakenly entering a short wave cutoff that is longer than the 
currently selected long wave cutoff, or shorter than the value of the analog cutoff. For scan 
speeds greater than 5 µmis, the shortest short wave cutoff selection turns off the short wave 
cutoff filter. 

If subsequent changes to the scan speed or scan length cause the short wave cutoff setting 
to become invalid, the cutoff is automatically changed to the nearest available valid value 
(possibly the default). 

The default cutoff depends on the scan speed and sampling rate. The full range of default 
short wave cutoffs is listed in Table 6-2. 
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Table 6-2 Default Short Wave Cutoffs 

Scan Speed Sampling Short Wave Cutoff Short Wave Cutoff 
(µmis) Rate(Hz) Frequency (Hz) Wavelength (µm) 

1: RC Gaussian RC Gaussian 

I 50 4 6 0.25 0.17 

100 7.5 12 0.13 0.08 

200 15 24 0.067 0.042 

500 37.5 60 0.027 0.017 

2 50 4 6 0.5 0.33 

100 7.5 12 0.27 0.17 

200 15 24 0.13 0.083 

500 37.5 60 0.053 0.033 

1000 75 120 0.027 0.017 

5 50 4 6 1.3 0.83 

100 7.5 12 0.67 0.42 

200 15 24 0.33 0.21 

500 37.5 60 0.13 0.083 

1000 75 120 0.067 0.042 

10 50 4 6 2.5 1.7 

100 7.5 12 1.3 0.83 

200 15 24 0.67 0.42 

500 37.5 60 0.27 0.17 

1000 75 120 0.13 0.08 

20 50 4 6 5.0 3.3 

100 7.5 12 2.7 1.7 

200 15 24 1.3 0.83 

500 37.5 60 0.53 0.33 

l000 75 120 0.27 0.17 

50 50 4 6 13 8.3 

100 7.5 12 6.7 4.2 

200 15 24 3.3 2.1 

500 37.5 60 1.3 0.83 

1000 75 120 0.67 0.42 

100 50 4 6 25 17 

l00 7.5 12 13 8.3 

200 15 24 6.7 4.2 

500 37.5 60 2.7 1.7 

1000 75 120 1.3 0.83 
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Table 6-2 Default Short Wave Cutoffs 

Scan Speed Sampling Short Wave Cutoff Short Wave Cutoff 
(µm/s) Rate (Hz) Frequency (Hz) Wavelength (µm) 

RC Gaussian RC Gaussian 

200 50 4 6 50 33 
100 7.5 12 27 17 
200 15 24 13 8.3 
500 37.5 60 5.3 3.3 
1000 75 120 2.7 1.7 

400 50 4 6 100 67 
100 7.5 12 53 33 
200 15 24 27 17 
500 37.5 60 11 6.7 
1000 75 120 5.3 3.3 

1000 50 4 6 250 170 
100 7.5 12 130 83 
200 15 24 67 42 
500 37.5 60 27 17 
1000 75 120 13 8.3 

2000 50 4 6 500 330 
100 7.5 12 270 170 
200 15 24 130 83 
500 '37.5 60 53 33 
1000 75 120 27 17 

5000 50 4 6 1300 830 
too 7.5 12 670 420 
200 15 24 330 210 
500 37.5 60 130 83 
1000 75 120 67 42 

10000 50 4 6 2500 1700 
100 7.5 12 1300 830 
200 15 24 670 420 
500 37.5 60 270 170 
1000 75 120 130 83 

25000 50 4 6 6300 4200 
100 7.5 12 3300 2100 
200 15 24 1700 1000 
500 37.5 60 670 420 
1000 75 120 330 210 
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To set the long wave filter cutoff values: 

1. From the recipe window, click on Filters/Cursors to open a dialog box. 

2. Tab to the Waviness entry field to enter a wavelength (in µm), or click on the drop
down arrow to choose a value from the range of cutoff filters provided. You can also 
tum off the filter. Selectable values are listed in Table 6-3. 

Table 6-3 Long Wave Cutoffs 

µm mil µm mil mm mil mm mil 

4.5 0.18 so1 3.01 1.4 56 25.0 1,000 

8.0 0.30 140 5.6 2.5 1001 45.0 1,800 

14 0.56 2501 10.01 4.5 180 - -

25 LO 450 18.0 8.0 300 - -

45 1.8 soo1 30.01 14.0 560 - -

1 Cutoffs specified in ANSI B46, 1-1985 

Up to 17 filter choices are available depending on the scan speed. You are prevented from 
mistakenly entering a long wave cutoff that is shorter than the currently selected short 
wave cutoff or the value of the analog cutoff. 

If subsequent changes to the scan speed or scan length cause the long wave cutoff setting 
to become invalid, the cutoff is automatically changed to the nearest available valid value. 

The following figures show the effect of different cutoff filter settings on the same set of 
scan data. 
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Figure 6-21 Signal Transmission Curves and Their Effects on Scan Data 
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In Figure 6-21(a), only the analog filter acts on the data. Three wavelengths, labeled 11.1, 

11.2, and 11.3, are identified. 

In Figure 6-21 (b ), the long wave cutoff filter is applied with a cutoff value just higher than 
11.1. The resulting data trace shows only features of the scale of "'I; higher wavelengths, 
including A-2 and A.3, are suppressed. 

In Figure 6-2l(c), a different long wave cutoff value is applied, this time just higher than 
A-2. The resulting data trace shows features of the scale of "'I to J..i; higher wavelengths, 
including ,...,3, are suppressed. 

In Figure 6-21(d), a short wave cutoff filter with a cutoff just higher than "'l is applied in 
addition to the long wave cutoff from Figure 6-21(c). The resulting data trace shows only 
features of the scale of A-2; higher wavelengths, including 11.3, and lower wavelengths, 
including "'1, are suppressed. 

In Figure 6-21(e), the short wave cutoff filter is applied with a cutoff value just lower than 
A.3. The resulting data trace shows only features of the scale of 11.,3; lower wavelengths, 
including "'I and A2; are suppressed. 

Finally, in Figure 6-21(f), the short wave cutoff filter is applied with a cutoff value just 
lower than 11.,2. The resulting data trace shows features of the scale of ,...,2 and 11.,3; lower 
wavelengths, including A-1, are suppressed. 

6.5 RADIUS MEASUREMENT ON CURVED SURFACES 
The average radius of a circular segment defined by the measurement cursors is calculated 
from a data set using the least squares fit method. This method is capable of high precision. 
It is useful over a range from 0.5 µm (20 µin.) to 200 mm (7.9 in;), provided that the sample 
will fit into the instrument. 

You should keep in.mind that the radius of the measurement stylus is added to the sample 
radius in the measurement. While the radius of a 2-µm stylus added to a 20-mm radius 
sample might be considered negligible (0.0 I%), that of a 5-µm stylus added to a 1-mm 
radius is a 0.5% error, which is probably not acceptable. 

This consideration disappears if the instrument is calibrated with a high precision cylin:
drical standard whose radius is within a factor of 5 of the sample to be measured. For the 
highest accuracy, we recommend that you perform this calibration. 

Note that this calibration is only effective when radius measurement is enabled by setting 
the Radius parameter to Display or Yes in the Scan recipe. This means also that the radius 
measurement should be disabled by setting the Radius parameter to No in the Scan recipe 
when the instrument is used for other types of measurements. 

For maximum precision, the height of the measured arc and the size of the included angle 
must be within certain limits. These limits depend on the type of measurement head you 
are using. The height of the measured arc should be limited to 77% of the vertical range 
of the measurement head, and the included angle to 90°. Measurements can be made up 
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to 90% of the vertical range of the measurement head in arc height and 110° in included 
angle with a small loss of precision. , 

j • L .. 
---- f ··(----------------------

H ! 
___ J ____ l 

R 

Included angle up to 90° 

Figure 6-22 Arc Segment Dimensions 

Precise measurement is also restricted to arc segments that are symmetric to the radial axis 
of the measured artifact. To measure another portion of the radius, the sample must be 
physically rotated about the radial axis. 

Scan length and scan speed are dependent on the radius of the sample and the arc height 
allowed by the measurement head and its vertical range. For a given radius Rand optimum 
arc height H (Fig. 6-22) the optimum scan length L can be determined by the following 
formula: 

L = 2J2RH-lf2 

Scans taken at the lowest possible horizontal resolution for the optimal scan length 
generally yield the most repeatable and precise radius measurements. To achieve the 
lowest horizontal resolution, you might have to try various combinations of scan speed 
and sampling rate. Start with a 200 Hz sampling rate, then set the scan speed to get a scan 
time that is as close as possible to 25 s without exceeding it. If the longest scan time possible 
under these restrictions is 12 s or less, set the sampling rate to 100 Hz, and. then set the 
scan speed so that the scan time is as close as possible to 50 s without exceeding it. 

Use the center bias profile type if the arc height His less than about 40-45% of the range 
available with your measurement head. Otherwise, use either the peak bias (for convex or 
hill-like radii) or the valley bias (for concave or valley-like radii), as appropriate. 

The stylus force needed depends on the arc height Hand on the profile type (peak, valley, 
or center bias). You must set the stylus force high enough for the stylus to reach the lowest 
points of the scan. If, while measuring a radius, the trace flattens out and no "data out of 
range" message is displayed, try a higher stylus force setting. 
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A 1-cr repeatability (precision) of 0.002% of the radius is routinely obtained when you 
follow a few simple rules: 

• Do not use software leveling on the scan data (that is, set both leveling cursors to 
zero). 

• Preset the position of the measurement cursors. 

These rules are followed when the Scan recipe is set up as follows: 

Recipe Field 

Scan Length 

Scan Speed 

Sample Rate 

Surface Parameters 

Stylus Force 

Profile Type 

Vertical Range 

Cursors (relative) 

Setting 

See formula earlier in this section. 

See discussion earlier in this section. 

200 Hz if possible (see discussion earlier in this 
section). 

Enable display of Radius and Distance 

See discussion earlier in this section. 

See discussion earlier in this section. 

To range necessary to accommodate sample. 

Left Right 

Measurement L = 2J2RH-lfl L = 2J2RH-1fl 

Leveling 0 0 

Delta Meas 0 0 

Delta Lev 0 0 

For convex radii, the cursors automatically adjust whenever the Edge and Radius param
eters are selected in the Scan recipe, and Feature Detection (set for Apex) is enabled, 

For 0.002% repeatability, adjust the measurement cursors in the Data Analysis window 
so that the height values for the cursors are equal within 0.5 µm (20 µin.) for radii larger 
than 2.5 mm (0.1 in.). 
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6.6 FIT AND LEVEL 
The Tencor P-20h software is capable of accurately measuring step heights on curved 
surfaces ( such as lenses .or g1ass optical fibers), or in the case of a bow in a profile that has 
been leveled in the normal manner. This capability is enabled or disabled in the Scan recipe. 

NOTE: The software can remove a simple convex or concave curve from 
the data, but not more complex curves like waves. 

To activate Fit and Level: 

Enable the Fit and Le¥d check box in the Feature Detection dialog box of the Recipe 
Editor. 

6.7 SAVING AND MAINTAINING SCAN DATA 
Scan data can be saved for reviewing at a later time. 

To save scan data: 

1. Choose Save Data from the File menu. The following dialog box appears: 

2dscan1 
jed_248 
jed_33 
scn65 
lffitil-
test2 
testJ 
test4 
tst265 

New ~!-lbdireclory: 

SCAN DATA 

,;,,SCAN DATA 
~pctOl 

Driye: 

Figure 6-23 Path and Data Name Dialog Box 

I 

2. Select the drive and subdirectory. 

Y Oll can also create a new subdirectory for the new data set by typing a name into 
the subdirectory field. The new subdirectory then appears in the pathway above the 
directory window. 

3. Type a name for the data set, then click on OK, or click on Cancel to abort the Save 
operation. The data set name must be a valid DOS filename. Valid DOS filenames 

• Can contain a maximum of eight characters 

• Have a three-character extension supplied by the system 

• Are not case-sensitive 
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• Can contain only the letters A-Z, the numbers 0-9, and the following special 
characters: tilde(~), exclamation point(!), at sign(@), number sign(#), dollar 
sign ($), percent sign (%), caret ("), ampersand (&), left parenthesis, right 
parenthesis, underscore U, hyphen (-), left brace ( {), right brace (} ), single 
quotation mark('), and apostrophe('). No other special characters are acceptable 

• Cannot be identical to the name of another existing data set 

4. Click on OK to enter the path and data name. 

Once a data set has been saved, it is added to the Scan Data catalog. The Scan Data catalog 
window allows you to select individual data sets for reviewing. You can also delete 
unwanted data sets. 

To view the Data catalog: 

From the Catalog window, click on the Scan Data butto11 on the left side of the 
screen. The Scan Data Catalog window appears: 

Scan Data Name: !2DSCAN1 ~------
Scan Data Path: Scan Data Recipe ID Length No.of c,ealion 

(um) Points Dale 

- =' ~ 'i!'i" -- """ 11/29/95 30MM-180 944. 1894 
JEDSCAN1 500 1004 ll/29/95 
JED3D1 597 1198 11/29/95 

20SCANI JE0_33 JED_248 TST265 

Drive: 

I 

Figure 6-24 Scan Data Catalog Window 
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To review a data set: 

Select the desired data set from the list in the catalog, and click on the Review button, 
or double-click on the desired data set. 

To delete, import, and export data, see Chapter 9, "Using the Database." 
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7 ANALYZING 3D SCAN DATA 

Once a 3D scan has been completed, the computer processes the measurement data and 
displays it in the Data Analysis window. This chapter discusses how data from a 3D scan 
is displayed and how to manipulate and analyze it. 

This chapter describes 

• Parts of the 3D Data Analysis Window 

• How to customize images 

• How to analyze 3D data 

• Leveling the data 

7.1 DATAANALYSISWINDOW 
When a scan is completed, the Data Analysis window appears, showing a three-dimen
sional, color representation of the data points collected in one of three selectable formats: 

lilS414 
mm 

Z(l) 1111111 

"° lOO 

l>i 
T(lal 100 

,,,,,_, 

By Height: the higher the feature, the 
lighter the color. Good for viewing ro\lgh 
features. 

By Light: features appear as if illuminat
ed by a light source. Good for viewing 
smooth features since contours are more 
obvious. 

By Line: only the data points are plotted, 
giving a wire frame effect. Unlike the 
other two formats, it does not "fill in" 
between the scan lines with interpolated 
data to create the look of a solid object. 
Good for viewing surface detail. 
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Figure 7-1 Data Analysis Window, image displayed in By Light format 

7.1.1 DATA ANALYSIS MENU BAR 
Most of the data manipulation and analysis of 3D scans is performed using either the 2-D 
view of the 3D scan or a single XY trace that you select from the 3D scan. Therefore, 
many of the tools you use for 2D data analysis you will use with 3D scan data. 

The menu bar for 3D analysis adds the following two menus for operations specific to 3-D 
data manipulation: 

Figure 7-2 File Menu 
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Figure 7-3 View Menu 

7.1.2 DATA ANALYSIS TOOL BAR 
The Data Analysis tool bar contains 3D image orientation buttons that provide a quick 
alternative to changing the view angle of the scan using the View menu and Rotation 
buttons 

Clicking on disp.lays the image as if you are 

in front and to the left of the scan. 

in front of the scan. 

in front and to the right of the scan. 

in back of the scan. 

at the end of the scan. 

You can also use the Rotate Arrows at the bottom of the 3D View window to obtain more 
customized views. 
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7 .1.3 GRAPHICS TOOLS 
These tools, located at the far right of the menu bar, are active when the ZD view of the 
3D scan is selected. 

Zoom In-Allows you to scale up a selected feature. 

Undo Zoom-Returns the scan view to the original scale. 

Ruler-Allows you to select a single scan trace for 2D display and data 
analysis. 

Level-Allows you to level a 3D scan. 

Height Tool-use to measure the height of a specific area on the scan. 

Step Height-. use to designate two areas on the scan. for step height 
measurement. 

7.2 CUSTOMIZING THE SCAN IMAGE 
Z determines the relative height of the scan in relation to the X and Y axes, allowing you 
to customize image proportions. 

To set image proportions: 

1. Select Change View from the View menu. The Set 3D View Parameters dialog box 
appears. 

2. Type a number that gives a satisfactory height to the image. Since the number 
depends on the relative heights of the features in the image, choose a higher value 
to obtain a taller image, a smaller value to reduce it. 

3. Click OK to close the dialog box and apply your choice. 

The computer records more data points than are possible to plot onscreen, so it uses a 
subset of the points taken to build the image. In general, the smaller the subset, the coarser 
the image and the faster it can be displayed and rotated. You can control the image 
granularity from coarse to fine by setting parameters for the data subset. For instance, a 
setting of 3 plots every third data point and represents a subset one~third the size of the 
original data set. 
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To set x and y granularity; 

1. Select Change View from the View menu. The Set 3D View Parameters dialog box 
appears. 

2. Type a number in either or both X and Y granularity fields. A larger number than 
the currently displayed value increases granularity; a smaller number decreases it. 

3. Click OK to close the dialog box and apply your choice. 

You can customize your 3 D data images to better represent your substrate type by selecting 
a shading mode. Choose By Lines for a wire frame effect, By Height to emphasize high 
features, and By Light to enhance smooth surfaces. 

To select the shading mode: 

1. Select Change View from the View menu .. The Set 3D View Parameters dialog box 
appears. 

2. Select By Lines, By Height, or By Light. 

If you choose By Light, you can optimize its effect by changing the position of the 
light source: 

In the box below the Shading Mode, enter Rise and Rotation angles from 1 ° to 90°. 
The reference point for these angles is an imaginary center located on the X-axis 
halfway down its length. The numbers you enter represent locations clockwise and 
up from this point. 

3. Click OK to close the dialog box and apply your choice. 

To change your angle of view: 

You can view the image from various angles using four different features: 

Orientation selections on the View menu: Select the View menu and click on one of the 
five views listed at the end of the menu; 

Orientation tool bar: Click on the face icon corresponding to the desired angle .. Also, 
clicking one of these buttons returns you quickly to 3D view from 2D views. 

View Vector Settings---choosing a specific angle of view: 

I. Select Change View from the View menu. 
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2. Enter angles for the desired viewpoint in the data entry fields. 

The Rise setting rotates the image around its X-axis. Entering a 90° rise setting stands 
the image on edge, giving a top-down view; a 45° rise tilts the far side of the image 
away from you. See Figure 7-4. 

288581 
200000 

z c.£) 100000 
240 

200 

150 

y (µrn) 100 

50 

0 
0 0 0 0 0 0 0 0 0 

"' 0 "' 0 "' 0 "' 0 .... .... N N ("1 ("1 v 

X(µrn) 

Figure 7-4 View Vector Settings: Rise 45 °, Rotation 0° 

The Rotation setting pivots the image counterclockwise on its XY plane. A 0° 
rotation aligns the X and Y axes with the window frame in a straight-on side view 
(Figure 7-5); 45 ° rotates the image to lie diagonally across the window. You can 
even enter rotations up to 359 ° to rotate the image completely around to the "back" 
side. Figure 7-6 shows the image at 45° rise and 45 ° rotation. 

3. Click OK to close the dialog box and apply your choice. 
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Figure 7-5 View Vector Settings; Rise 0°, Rotation 45 ° 
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Figure 7-6 View Vector Settings: Rise 45 °, Rotation 45 ° 

Rotation Tools 
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The rotation tools at the bottom of the 3D view window give you a quick way to examine 
the image from continuously changing points of view. 

You can choose from a palette of 42 basic colors for your images or mix your own from 
the custom paintbox. 

To customize image colors: 

1. Choose Select Colors from the View menu. 

2. Click on the desired color or on Define Custom Color if you want to mix your own. 
Saving the scan file also saves custom colors. 

3. Click OK to close the dialog box and apply your choice. 
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You can color-code images displayed in the By Height format to better delineate height 
features. The Highlight Ranges feature lets you assign different colors for different height 
ranges, giving a topographical representation of the substrate. 

To color-code the scan for height: 

1. Select Highlight Ranges from the View menu. A dialog box appears, giving the 
minimum and maximum heights obtained in the scan and two parameter entry fields. 

2. In the range top and bottom entry fields, type values for the top and bottom 
boundaries of the height range. 

3. Click Select Highlight color. 

4. Choose a color from the palette or mix your own. 

5. Click OK. The Highlight Height Range dialog box reappears. 

6. Repeat for as many ranges as you want to define. 

7. Click OK to enter the parameters and apply the ranges to the scan. 

You can set the image to automatically expand to the largest size the window allows. 

To size the image to fill the window: 

1. From the View menu, select Change View 

2. Click on the box next to "Maximize itnage to fit window," at the bottom of the dialog 
box. 

To deactivate the maximize option, click on the box again to uncheck it. 

You can display any or all open windows, including the 3D scan and the 2D trace 
you select from it. 

To view 2D traces and 3D scans at the same time: 

1. To display a single trace from the 3D scan: 

• From the 3D scan, choose 2D View from the File menu. The 3D image 
rotates to an XY, top-down viewpoint and the Graphics tool bar appears in 
the menu bar. 

• Click on the Zoom In tool. A framed box appears on the scan. 

• Click and drag across the area you want to select. Use the magnifying 
crosshair to locate your starting and end points. 
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• Choose Select 2D Trace from the File menu to open a new window display
ing the single trace in XY view. 

2. To open multiple windows, choose a tile selection from the Windows menu. Tile 
Horizontal usually works best. 

7.3 ANALYZING SELECTED FEATURES 
Viewing a particular feature in a 3D scan requires that you display it in 2D View. 

To zoom in, 3D View: 

1. Choose 2D View from the File Menu. 

2. Click on the Zoom In button on the Graphics tool bar on the right side of the menu 
bar. 

3. Click and drag to draw a box around the feature you want to enlarge. 

When you release the button, the feature appears, full size, with axes rescaled in 
proportion. 

To zoom in, 2D Trace: 

1. From a 2D trace view, click the Zoom In button on the left of the menu bar. The 
zoom tools on the Graphics tool bar on the right are active only for 3D scans. 

2. Position the arrow cursor on the scan and click and drag from one side of the desired 
scan segment to the other. Vertical cursor lines appear, one on each end of the 
segment. 

3. Release the trackball button. The scan rescales to display only the selected segment. 

To undo zoom: 

There are two ways to return to the original scan magnification: 

• Use the Undo Zoom tool on the left side of the tool bar for 2D Traces. Use 
the Undo Zoom tool on the Graphics tool bar for 2D Views of 3D scans (See 
the following note for an explanation of 2D Traces and 2D Views). These icon 
buttons reduce magnification in steps back to the original scale. Click on the 
button until the feature zooms out to the desired scale. 

• To return in one operation to the original scan scale, select Undo Zoom from 
the Operations menu. 
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7.4 DATA LEVELING AND MEASUREMENT 
Data leveling and measurement is performed from the 2D view of the 3D scan using the 
Graphics tool bar. 

Recipe: STEPS 
Length: 200 µm 
Speed: 20 µm/sec 
Direction .:. 
'II- o1 Traces: 1 0 
force: s mg 

i 
;;.-

90.9! 

81.819 

72.728 

63.637 

5i.5i6 

t'-455 

36.36i 

27.273 

18.182 

9 .091 

0 18.2 36,I st.6 72.8 91 109.2 127.4: 1,s.& 163:8. 182 

X(o<m) 

Figure 7-7 2D View of a 3D Scan 
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NOTE: 2D View and 2D Trace refer to different representations of 3D scan data. A 
window displaying a 2D View is actually the 3D scan as it appears from directly above, 
from the top down. In this view, scan features appears flat, their shapes indicated by 
gradations of color.. To provide a quantitative indicator of height (the Z scale), the 2D 
View screen includes a ruled strip beside the scan window color-keyed to indicate the 
range of heights in the scan (Fig. 7-7). Displaying a 2D View requires the selection of the 
2D View from the File menu. 
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Figure 7-8 A 2D Trace (top window) from the selected trace of the 2D View 
(bottom window) 

On the other hand, a 2D Trace is an actual XY plot of one of the traces comprising the 
3-D scan. Onscreen, it looks like a 2D scan, and you can perform data analysis on it just 
as you would for a 2D scan. From the 2D View of the 3D scan (described above) you 
select which scan to display using the ruler on the Graphics tool bar. To display the trace, 
you choose Select Trace Scan from the File menu (Fig. 7-2). 

7.4.1 DATA LEVELING 
Software data leveling of 3 D scan data is much the same as for 2D scan data (Section 6 .2, 
"Data Leveling and Measurement). However, 3D data leveling must allow for an addi
tional spatial dimension, so it is performed using three leveling cursors. 

To level data: 

1. Select 2D View from the File menu. The screen shows the 3D scan from the top 
down. 

2. Click on the Leveling Triangle on the Graphics tool menu bar. 

3. Position the arrow on the scan and click to place the first of three cursors. A small 
box marked "l" appears, forming the first vertex of the leveling triangle. 
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4. Repeat this step to set the other two cursors of the leveling triangle. 
You can also click and drag between cursors. To change the cursor positions, click 
and drag each one to the desired position. 

5. Click on the Level button in the tool bar or select Level from the Operations menu. 
The scan will be leveled according to the areas marked by the three cursors (not the 
connecting lines). 

6. To record the positions of the level cursor in the scan recipe, select Recalc from the 
Operations menu. 

7.4.2 USING 3D SCANS FOR 2D DATA ANALYSIS 
1. From the 3D scan, choose 2D View from the File menu. The 3D image changes to 

a top-down view and the Graphics tool bar becomes active. 

2. Click on the Zoom In tool. A framed box appears on the scan. 

3. Click and drag across the area you want to select. Use the magnifying crosshair to 
more precisely locate your starting and end points. 

4. Choose Select 2D Trace from the File menu to open a new window displaying the 
single trace in XY view. 

7.4.3 MEASUREMENT 

To measure average height: 

1. Choose 2D View from the File menu. The scan appears as viewed from the top down. 

2. Click on the ruler tool of the Graphics tool bar to activate the measurement cursor. 

3. Position the arrow at the starting point of the feature you wish to measure. 

4. Click apd drag to the endpoint of your measurement. The arrow becomes an enlarged 
crosshair that magnifies the detail of the underlying area, which allows you to more 
precisely set your starting and end points. A framed box marks the length of the 
measurement along the X axis. 

Measurement values appear in the Trace Information area to the left of the scan. 

5. To record the positions of the level cursor in the scan recipe, select Recalc from the 
Operations menu. 

To measure step height: 

1. Choose 2D View from the File menu. 

2. Click on the Step Height tool of the Graphics tool bar to activate the measurement 
cursor. 

3. Position the cursor arrow near an area you wish to include in the measurement. 

4. Click and drag the box around the area. Release the button. 
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i 
5. In the same manner, draw another box around the area you wish to compare it to. 

The measured values and box parameters appear to the right of the scan. 

6. To record the positions of the level cursor in the scan recipe, select Recalc from the 
Operations menu. 

7 .5 X START LEVELING 
X Start Leveling is a 3D scan parameter option found in 3D scan recipes that starts the 
beginning of each successive scan at the same height. Using X Start Leveling removes 
bow from the scan, makes surface features stand out, and helps to reduce the effects of 
mechanical noise. 

1. Open the recipe for the scan, or create a new one (see Section 4.2, "Recipe Editor 
Window). 

2. Check the box beside the words, "X Start Level." 

3. Click OK to close the dialog box and apply your selections. 
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8 SEQUENCING 

The Tencor P-20h allows you to write a sequence, which instructs the instrument to take 
a series of scans rather than you taking them all manually one by one. A sequence is like 
a script that links specific scan sites on a sample ( or on a number of samples) with specific 
scan recipes to be performed at each site. The capability of automating repetitive measure
ments greatly enhances the productivity of the instrument. 

This chapter covers 

• Sequencing capabilities of the P-20h 

• The Sequence Editor window 

• Sequence Editor fields 

• A simple sequence example 

• Sequencing with Manual Deskew and Pattern Recognition Deskew 

• Sort options 

• Sequencing with the wafer handler 

• Saving and maintaining sequences, and printing sequence data 

8.1 SEQUENCING CAPABILITES 
The Sequencing provides the following measurement capabilities: 

• Combine as many artifact sites and recipes as desired 

• Set reference points for correcting for translational and rotational variation between 
wafers (deskew) 

• Deskew can be set manually or automatically using Pattern Recognition 

• Set Pattern Recognition options to search locally for a match when a match is not 
found in the camera's field of view at deskew sites and carry out user-selected 
instructions if the search fails 

• Set the wafer handler to load, scan, and unload up to 26 wafers without operator 
intervention 

• In Multiple Analysis mode, apply different recipes to a single scan 

• Automatically display, print, export and save statistics or raw data for all sites 

• Teach scan sites and alignment reference points interactively, with or without theta 

• Unload wafers that do not meet pass/fail criteria into a designated cassette 
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8.2 SEQUENCE EDITOR WINDOW 
The Sequence Editor window contains the controls for writing and editing sequence 
programs, setting various sequence options, and running the sequence program. The 
Sequence Editor is started from the Sequence Recipe Catalog. (See Section 4.1.1, "Scan 
Recipe Catalog Menu Bar," and Section 4.1.2, ''Scan Recipe Catalog Tool Bar," for a 
description of the menus and tool bar buttons that appear in the Sequence Recipe Catalog 
window.) 

To view the Sequence Editor window: 

1. From the Top Level menu, double-click on the Scan icon. The Sequence Recipe 
Catalog window appears: 

Sequence 

JEDl 2D 

SEQA2 
SEQB2 
SEQClA 

Sequence Recipe Name: ~!JE_D1_2 ___ ~ 

Created "y Creation Date 

11/25/ 95 16 :19 

11/29/ 95 16 :49 
11/29/ 95 16 :33 
ll/29/ 95 16 : 33 

Figure 8-1 Sequence Recipe Catalog Window 

2. Click on the View/Modify button below the list of sequence recipes, or double-click 
on any of the sequence recipes in the list. The Sequence Editor window appears 
(Fig. 8.-2). 
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The Sequence Editor window consists of the following elements: 

• Menubar 

• Tool bar 

• Recipe catalog for selecting from available recipes 

• Options section for setting sequence options 

• Control buttons for sequence programming 

• Sequence list, linking sites with recipes 

800 
4B38 

-1000 
800 

4B40 
-1000 

800 
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Sequence List 

lLOO 
2 . 00 
0 . 00 

11 . 00 
2 . 00 
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8.2.1 SEQUENCE EDITOR MENU BAR 
The Sequence Editor menu bar provides access to commands through its menus. You can 
view menus by clicking on the titles in the menu bar, or by pressing ALT+!, where l is the 
letter that appears with an underscore in the desired title in the menu bar. You can choose 
menu items by clicking on a menu entry or by typing the letter that appears with an 
underscore in the desired menu item. 

Figure 8..J Sequence Menu 

Figure 8-4 Edit Menu 

Figure 8-5 Substrate Menu 
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• Figure 8-6 Vacuum Menu 

8.2.2 SEQUENCE EDITOR TOOL BAR 
The Sequence Editor tool bar contains a row of icons that resemble buttons. Clicking on 
these icons provides an alternative way to access commonly used functions. 

Each icon suggests the function of the button. For example, the Print button resembles a 
printer. Buttons that appear dimmed are unavailable. 

The Sequence Editor tool bar contains the following buttons: 

Button Action 

Loads a new default sequence 

Displays the File Open dialog box 

Saves the current sequence 

Displays the Print dialog box 

Starts a scan using the current Sequence 

8.2.3 SEQUENCE INFORMATION DIALOG BOX 
The Sequence Information dialog box displays the title, author, the date and time of 
creation ( or modification) of the sequence, and a section for annotating the sequence with 
comments. 

To display the Sequence Information dialog box: 

Choose Info from the Sequence menu. 
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The Sequence Info dialog box also appears when you are saving a sequence. 

Name: 
User: 
Modified: 03/0.f/94 15:53:35 
Comments: 

Figure 8-7 Sequence Information Dialog Box 

The Name, User, and Modified fields are supplied automatically by the system. These 
fields cannot be edited. 

To enter Comments: 

1. Click in the Comments text box or press TAB+- or TAB• until the Comments text 
box is highlighted. 

2. Type the desired text. 

8.2.4 SEQUENCE EDITOR RECIPE CATALOG 
The Sequence Editor Recipe catalog is a list box for displaying and selecting recipes. It 
has a vertical scroll bar to allow display of all currently available stored recipes. 

To select a recipe: 

Locate the desired recipe name. If the name is not visible in the window, use the 
scroll bar to find it, or click on any of the recipe names and then press [ A] or [ v] to 
move the selection bar up or down. 

Note: Sequencing is not currently available for 3D scans. 

8.2.5 OPTIONS 
The Options section allows selecting the sequence mode and setting the Data, Handler, 
and Sort options for the sequence. You can also select to run the sequence in Semi
Automatic mode. 
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SEMI-AUTOMATIC MODE 
The Semi-Automatic mode causes a sequence to display the trace data after each scan and 
pause before proceeding to the next step. Each step can be verified and, if needed, the scan 
sites can be adjusted and the scan retaken before proceeding to the next step. In Pattern 
Rec. Deskew mode, you can manually adjust the position of the stage in case the deskew 
site does not appear in the field of view when the sequence begins. 

Enable the Semi-Automatic mode by clicking on the check box. An X in the check box 
indicates that the Semi-Automatic mode is enabled; a clear check box indicates it is 
disabled. 

Mode 
Select the Sequence mode from the drop-down list. The available modes are 

No Deskew 

Manual Deskew 

The sequence contains no deskew points for alignment. 

Sequence deskew points are set much like scan sites. 

Pattern Rec. Deskew Sequence deskew points are set using the Pattern Recognition 
option. 

Fail Options 
Select the action you want taken if pattern recognition fails to find a deskew point. Fail 
options are 

Proceed Measurement 

Skip, No Measurement 

Retry Pat. Rec. Manually 

Cancel Sequence 

Continue with the scanning sequence. 

Measurement of that wafer is suspended. 

Allows user to perform a manual deskew. 

Sequence is suspended. User must restart. 
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DATA OPTIONS DIALOG BOX 

Set the Data options by clicking on the Data Options button in the bottom of the Options 
dialog box. The Data Options dialog box appears: · 

Save Options 

@:'t.i'o.riel 
0 Statistics 

0 Trace Data 

0 Use Lot ID 

@Use Name: 

IJED12 

Print Options 

Export Options 

@None 

0 Statistics 

0 Trace Data 

0 Use Lot ID 

@ ASCII File 

0 Binary File 

@ Use Name: ~IJE_D_1_2_~ 

D and use lot ID for statistics name 

0 Enable Auto Print 

Print: 

Figure 8-8 Data Options Dialog Box 

Make a selection from Print, Save, and Export options, click on the appropriate radio 
button. When finished, click on OK to- set the options and close the dialog box, or Cancel 
to close the dialog box without changing the previous settings. 

Each, group has the following possible settings: 

None 

Statistics 

Trace Data 

Prints, saves, or exports no data. 

Prints, saves, or exports only the statistics for the specified parame
ters, the recipe ID, part ID, and sequence ID. The results for each 
parameter at each measurement site are not printed, saved, or export
ed. Statistics are calculated for scans taken with the same recipe and 
are saved only if two or more scans are taken with that recipe. For 
information on the Combined Sequence Statistics Option, see the 
Section 8.15~ ''Combined Sequence Statistics (Optional)," following. 

Prints, saves, or exports everything, includihg the recipes used, the 
raw data points for each scan, parameter results, and the statistics. 
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The Export Options also contain a choice of export file type: 

ASCII File 

Binary File 

Data is exported in ASCII representation. 

Data is exported in binary representation. 

HANDLER OPTIONS DIALOG BOX 
Set the Handler options by clicking on the Handler Options button at the bottom of the 
Options dialog box. This displays the Handler Options dialog box (Fig. 8-23). 

The settings under the Handler Options dialog box are described in Section 8.12, 
"Sequencing with the Wafer Handler." 

SORT OPTIONS DIALOG BOX 
Set statistical pass/fail criteria for each recipe by clicking on the Sort button in the Options 
dialog box. Besides data entry fields for minimum and maximum data point, mean, 
standard deviation and range, the Sort Options window lists the corresponding values from 
the previous scan to provide a side-by-side reference for setting values. From this dialog 
box, you also can choose to include failed slots in the cassette summary. 

8.3 WRITING A SEQUENCE 
This section covers the basic outline of a sequence. The sections that follow discuss in 
more detail some of the operations outlined in this section. 

Note: Sequencing is not currently available for 3D scans. 

The steps in writing a sequence need not follow a specific order, except for the following: 

• The Sequence Editor needs to be opened first. 

• The sequence sites must be taught before the sequence can be saved. 

All steps may not be necessary. For example, you may not need to edit the sequence. 

To write a sequence: 

1. Open the Sequence Editor by choosing View/Modify from the main Scan window. 
You can start a new sequence by choosing New from the Sequence menu, or edit an 
existing sequence by choosing Open from the Sequence menu and selecting the 
desired sequence from the dialog box. 

2. Add the desired recipes to the sequence list on the right side of the window by 
selecting a desired recipe and clicking on the Add>> button. 

3. Set the desired options. Enable or disable Semi-Automatic mode, select the Se
quence mode, set the Data Options for saving, printing, and exporting data, and set 
the Sort and Handler Options if needed. 

4. Load a wafer or sample. 

#271632 Rev. F 1196 

Page 180



8-10 Tencor P-20h Operations 

5. Teach the Base Angle if used. 

6. Teach the sequence sites. If Deskew is used, teach the two Deskew Sites first, then 
the steps. 

7. Edit the sites if needed. Select the desired site and click on the Edit X,Y, Theta 
button. Or, manually enter or modify the coordinates. 

8. Save the sequence by selecting Save As from the Sequence menu. 

To run a sequence: 

• Start the sequence by clicking on the Start button in the tool bar, or choosin,g Start 
from the Sequence menu. 

To stop a sequence: 

• Stop the sequence by clicking on the Stop Scan button in the Scan window. The 
handler automatically unloads the wafer. 

8.4 A SIMPLE SEQUENCE EXAMPLE 
This section provides a brief tutorial example describing the process of writing, setting 
up, and running a simple sequence on a single sample without deskew and without the 
handler. 

The example used throughout this tutorial follows a continuous sequence of steps. By 
carefully following the instructions, the windows that appear on your screen should be 
very similar to the example windows reproduced in this chapter. 

To work through this section, you will need 

• A sample to profile 

• One or more recipes 

We recommend a step-height standard for this purpose. You can use any recipe and modify 
it as you proceed. 

To write the sequence: 

1. Bring up the Sequence Editor window (Fig. 8-2) by choosing View/Modify from 
the Sequence menu of the Scan Application window. 

2. To make sure you begin with a blank sequence, choose New from the Sequence 
menu. Two entries, Video Calibration and Base Angle, appear in the sequence list 
on the right side of the window. The mode is set as No Deskew and the Data, Handler, 
and Sort options are set to their defaults. A Video Calibration step appears at the 
beginning of every sequence to assure accurate results for scan length teaching and 
for pattern recognition. It is only necessary if the optical magnification (zoom) has 
been changed. Base Angle is an offset angle relative to the wafer's flat or notch. 

3. Select one of the designated recipes in the Recipe Catalog list box. 
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4. Click on th.e Add button, or press ENTER. The name of the selected recipe appears 
as site 1 in the sequence list. 

5. Select another one of the designated recipes in the Recipe Catalog list box, or use 
the same one again, and add it to the sequence list in the same way. 

6. Add one more recipe to the sequence list in the same way. You now have three sites 
in the sequence list, each of which uses the chosenrecipe(s) to control the scan and 
calculate the results for that site. Next, you need to specify X and Y coordinates to 
each site (0 coordinates are only necessary if a stage rotation is incorporated into a 
sequence). 

7. Select the first site by clicking anywhere on the site 1 line in the sequence list, or 
use [A] and [v] to move the selection bar to site 1. 

8. Click on the Teach control button, or double-click on the selected sequence step. 
The Teach Location window appears: 

--.- _1._--.- _j_--.- _1._--.- -+-I ~~~-~-

4 
~ 
4 
~ 
4 

1------------'-~-------------it. Mode : XY 
X: -154 J.llD. 
Y e 41 )J ll 

Z : 50460 )Jll 

121 : 0 . 00 deg 

Figure 8-9 Teach Location Window 

1~ i)1nmu 
~':.¥.!¥'·~ 
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9. In the Teach Location window, the blue arrow superimposed on the cross hairs 
indicates the scan length and direction as defined in the recipe. The center of the 
cross hairs indicates the start-of-scan position. Locate an appropriate position to start 
a scan as follows: 

• Move the stage using the arrow buttons in the tool bar, or clicking in the round 
stage position control on the right of the video window. 

• When the desired feature is in the field of view, indicate the position to start the 
scan by clicking there on the video image. 

10. Click on OK, or press ENTER, to return to the Sequence Editor window. Note that 
the X and Y coordinates of the cross hair now appear to the right of the recipe name 
in the sequence step for site 1. 

11. Repeat the teach process for each of the other sites in the sequence list, moving to 
a different place on the sample for each. When you are finished, you should have a 
sequence list with the following lines: the optional Video Calibration step, the Base 
Angle step (not used here), and three scan sites with specific recipes and X and Y 
coordinates. 

12. Save the sequence by selecting Save As from the Sequence menu. 

To run the sequence: 

Start the sequence by selecting Start from the Sequence menu, or by clicking on the 
Start button in the tool bar. 

The Run application window appears, and the stage moves to the first site. The stylus 
descends to the sample surface and the first scan begins. When the scan is complete, the 
stylus lifts, the stage moves to site 2, and the second scan begins. When this scan is 
complete, the stage moves to site 3 and the third and final scan begins. 

At the end of the final scan, the stage returns to its initial position and the Scan Trace 
window appears. Choosing Sequence List from the File menu displays the Data Analysis 
window. Both windows can be resized, moved, minimized or maximized, as well as tiled 
for simultaneous display (Fig. 8-10) and the screen arrangement saved. See Section 2.6.9, 
"Moveable and Resizeable Windows." 
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Figure 8-10 Sequence Data Analysis Window 

8.5 MULTIPLE ANALYSIS 

8-13 
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Max . 

Range 
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S~e3 Inc 

' ubstr. 

You can obtain multiple data analyses from a single scan by applying the data analysis 
settings of additional recipes to its raw data. The process is a modification of a sequence 
recipe in which the instrument uses the first scan recipe to scan and analyze in the usual 
manner, then takes settings from the subsequent recipes to reanalyze the first recipe's scan 
data. 

You can save time and improve throughput by using multiple analysis for 

• Measurements that require more than one cursor setting, for example, two different 
step heights on a single scan 

• Measurements with different filter settings 

• Measurements with different surface parameters enabled in the recipe 
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To create a multiple analysis recipe and scan the sample: 

1. From the Sequence Recipe catalog window, click on a recipe, then View/Modify to 
open the Recipe Editor window. 

2. Select New from the Sequence menu. A blank sequence list appears. 

3. Set up the scanning recipe: 

• If you plan to scan with a recipe's existing settings, click on the name of the 
recipe you wish to scan with and add it to the list. 

• If you want to make changes to the recipe, click on its name in the list, then on 
Edit/Review to change any parameters and teach the cursor position. 

Note: If you want to teach cursor positions later from the scan trace, you 
must perform a Save As to create a new recipe----even if you make no changes 
to the recipe at this point. 

After saving the recipe, exit the Recipe Editor to return to the Sequence Editor 
window. 

Select the new recipe you just created. 

Click on Change to replace the original recipe (still highlighted) with the new 
recipe in the list. 

4. Set up the analyzing recipes: 

• From the recipe catalog list, click on a recipe containing the analysis settings 
you want. This recipe should have the same scan length, scan speed, sampling 
frequency, stylus force, contact speed, and range as the scanning recipe. 

• Make changes to the recipe as in step 3. You can also perform this step before 
compiling the sequence list, using the recipe to scan the sample and. teach the 
cursor positions. 

• Add the recipe to the sequence list. 

• With the recipe still highlighted, click on .Multi Analysis. This instructs the 
instrument not to scan the sample again but to reanalyze the data according to 
the recipe's data analysis parameters. (Note that the Multi Analysis button is not 
active (grayed out) for the first recipe in a sequence.) 

• Repeat the process as many times as needed. 

5. Click on Start to scan the sample. A Save dialog box appears. Type in a name to 
save the multiple analysis recipe and to start the scan. 

When the scan is complete, the scan trace for the first recipe (Site 1) appears on the 
screen. 
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To view results: 

1. Tile the windows to display the Sequence Parameter Summary window and the Scan 
Trace simultaneously. 

2. Click in the Sequence Parameter Summary window to activate it. Site 1 shows data 
analyzed with the first recipe in the sequence list; Site 2 data corresponds to the 
second recipe, and so on. 

3. To view each recipe's data set in both Trace and Summary windows, click first on 
the arrow in the Recipe drop down box in the menu bar and then click on the recipe's 
name. You can also click on the Site box in the summary table. 

4. To teach cursor positions (possible only if the recipe is new), display the trace for 
the desired recipe and set the level and measurement cursors as desired. Select 
Recalc from the Operations menu to enter the new cursors in the recipe. 

5. Save the data set as desired. 

8.6 VIEWING WAFER SUMMARY DATA 
The Sequence Parameter Data window displays the results of a sequence based on an 
individual wafer within a cassette, as well as across a sequence of wafers for the entire 
cassette. This information includes detailed data about one or· more sites scanned on a 
single wafer. 

To display the wafer summary data: 

Select Sequence Parameter Data from the Window menu of the Data Analysis window, 
as shown in Figure 8-11. 
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""'Tencor Instruments - , - . I,' 

.. I file Trace Operations Window Help . . 
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Deskew Sample Stal Analyze Height TIA .! 
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Ma• ·1.42182 µm 1.42381 µm 

Range 431 .1 A 360.5A 

Failed 51015 E.c (Dskw) 

Passed Slo13 

Inc -1.43050 µm 1.39625 µm 

Site2 Inc -1.42348 µm 1.39106 µm 

Site3 Inc -1.42964 µm 1.39427 µm 

Site4 Inc ·1.42l82µm l .38776 µm 

S~e5 Inc -1.43318µm 1.39948µm 

s~.6 Inc -1.44752µm 1.41086 µm 

Sie7 Inc -1.46493 µm 1.42381 µm 

Site8 Inc -1.43909 um 1.40216 um ""i 
\Substr. 

Figure 8-11 Sequence Parameter Data Window 

To view the entire Sequence Parameter Data screen from the Trace window, you need to 
maximize the Sequence Parameter Data window. 

Using the Sequence Parameter Data window, you can select recipes from the pull-down 
list on the left of the tool bar. This pull-down list displays all recipes that are included in 
the sequence. 
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To specify data on the Sequence Parameter Data window: 

Select Sequence Summary Options from the Operations menu of the Data Analysis 
window, as shown in Figure 8-12 below. 

Display Selections 

igi Cas:selle Summary 

igi Slol Summary 

igi Sile Lisi 

Display Order 

igi Deskew Field 

igi Analyze. Field 

0 Cass. summary; Slol summary for all slots; Site lisl fm all slots. 

® Cass. summary; Slol summary followed by Site lisl for each slot. 

, ..... , l• W I 
Figure 8-12 Sequence Summary Options Window 

The Sequence Summary Options window lets you specify the information on the Sequence 
Parameter Data window, including data for each site scanned on a slot (wafer) for the 
entire cassette or for an individual wafer within a cassette. 

You can view the Trace window for any of the sequence steps by clicking on the 
appropriate site number in the Sequence Parameter Data window. 

To view Sequence data with the corresponding trace, site-by-site: 

You can easily set up the screen to display a site's parameter data along with the trace itself. 

1. Open both Trace And Sequence Parameter Data windows. 

2. Choose Tile Vertically from the Windows menu. 

3. Size the windows to your satisfaction by clicking and dragging their frames. 

4. In the Sequence Parameter Data window, click on the numbered Site box of the trace 
desired. The Trace window displays the trace for that site. Repeat for other sites, 
displaying each trace in turn. 

5. To preserve this window orientation, select Save Workspace from the File menu. In 
the dialog box that appears, give the workspace a filename and click OK to save it. 

The next time you want to review both parameter data and trace, retrie:ve the 
workspace by choosing Load Workspace from the File menu. Then highlight the 
workspace name in the drop-down menu and click OK. The screen reconfigures to 
the identical trace/data window orientation. 
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8.7 TEACHING THE BASE ANGLE 
The Base Angle is an offset angle relative to a wafer's flat or notch. It is used to align 
scans with the wafer geometry. The Base Angle is fixed for all scans in the sequence. You 
can program this offset in the Teach Location window. 

To teach the Base Angle: 

1. Double-click on the Base Angle step in the sequence list. The Teach Location 
window appears (Fig. 8-9). 

2. Locate a line or die grid pattern to use for a reference. 

3. Click on the clockwise or counterclockwise rotation buttons in the tool bar until the 
cross hairs are aligned with the reference feature. You might have to move the stage 
to keep the reference feature in the field of view as you rotate. 

4. Click on OK, or press ENTER, to return to the Sequence Editor window. Note that 
the Base Angle now has a value instead of the phrase "not used." 

When you run a sequence with a non-zero Base Angle, the stage will rotate to that position 
immediately after the Video Calibration step (if used) and before taking scans. 

8.8 SEQUENCING WITH MANUAL DESKEW 
The reason for programming a sequence is to speed up a repetitive series of measurements 
on one or more samples. The example in Section 8.4, "A Simple Sequence Example," 
contains all of the essential features of a sequence. 

However, its usefulness is limited by the fact that no specific reference points were 
established. This might not be a problem if a precision locator is being used to position 
each sample on the stage and if the features being measured are relatively large. 

Without a locator or some sort of fixture, or without using the wafer handler, you would 
run into problems reusing this first sequence to measure another of these samples. Without 
fixturing, you cannot reliably put the second and subsequent samples on the stage in the 
same position and with the same alignment as the first. You can still use the sequence you 
have written, but you would have to manually find each of the scan sites and reteach them 
before running the sequence. 

Deskew enables you to identify two points on a sample to use as reference points prior to 
the start of a sequence. These points are then used to correct mathematically for transla
tional (X, Y) and rotational (theta) error in sample positioning. 

Note, however, that though a coordinate transformation is made, there is no stage rotation 
to compensate for the small rotational error in sample placement unless you set the deskew 
options to perform a second deskew. See Section 8.9, "Deskewing Twice to Align Theta," 
for more information. 
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Note also that any rotational error will be magnified when you traverse a long distance 
across a large wafer. This might cause the deskew site to be outside the field of view when 
a wafer is loaded. 

NOTE: To minimize positioning error, space the deskew points approxi-
. mately one-half the diameter of the sample. Do not set the deskew 

points parallel to the X- or Y-axis, but instead use two points on a 
diagonal line. If the deskew points are identical, the sequence 
aborts. 

When programming sites, choose a logical progression to reduce the total distance traveled 
and to save time, as in the following figure. 

3 8 

7 

6 

11 

12 

13 

14 

15 

18 

17 

16 

Figure 8-13 Logical Order of Sequence Sites 

To set up a sequence with Manual Deskew: 

1. Bring up the Sequence Editor window by choosing View/Modify from the Sequence 
menu of the Scan Application window. 

2. To make sure you begin with a blank sequence, choose New from the Sequence 
menu. Two entries, Video Calibration and Base Angle, appear in the sequence list 
on the right side of the window. The mode is set as No Deskew and the Data and 
Handler options are set to their defaults. (A Video Calibration step appears at the 
beginning of every sequence to assure accurate results for scan length teaching and 
for Pattern Rec. Base Angle is an offset angle relative to the wafer's flat or notch.) 

3. Set the Deskew mode to Manual Deskew. Note that two deskew steps now appear 
in the sequence list on the right side of the window. 

4. Select the first deskew site by clicking anywhere on the Deskew Site 1 line in the 
sequence list, or use [A] and [v] to move the selection bar to Deskew Site 1. 

5. Click on the Teach control button, or double-click on the selected sequence step. 
The Manual Deskew Teach window appears (Fig. 8-14). 
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Tencor P-20h Operations 

1------------'-~-------------il Mode : XY. 
X: -300 )Jm 
Y:. -517 µm 

Z:· 53761 µm 
0 , 0 .. 00 deg 

Figure 8-14 Manual Deskew Teach Window 

6. Choose a site for the first deskew point. Choose an obvious point, such as the corner 
of an easily identifiable rectangle. Click on the chosen position. The stage will move 
so that the cross hairs are centered on the selected site. 

7. Click on OK. The Sequence Editor window reappears, with the X and Y coordinates 
of the selected site entered in the Deskew Site 1 step. 

8. Select Deskew Site 2 and repeat steps 5-7 for the second deskew site. 

9. Once the deskew sites have been successfully established, proceed to programming 
the rest of the sequence steps. 

10. Run the sequence. After each deskew operation, the instrument pauses and waits for 
you to accept the deskew sites by clicking on OK. 

8.9 DESKEWING TWICE TO ALIGN THETA 
With a single deskew operation, there is no stage rotation to compensate for the small 
rotational error in sample placement You can choose to perform a second deskew to 
compensate for this error by enabling this option in the Deskew Options dialog box. This 
allows accurate sample rotations within a sequence. 
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To set deskew options to perform a second deskew to align theta: 

1. From the main Configuration window, click on the Deskew Options button. The 
Deskew Options dialog box appears: 

Perform Deskew Twice to Align Theta? D 

Pattern Rec. Options 

No. of Groping Relr,1' Layers: II 
Lowest Match Score (20--100%): ~ % 

Max. Score to Stop Groping (20--100%): D % 

Figure 8-15 Deskew Options Dialog Box 

i- , I-

2. Click on the check box to enable or disable the second deskew. 

3. When finished, click on OK to set the options and close the dialog box, or Cancel 
to close the dialog box without changing the previous settings. 

8.10 SEQUENCING WITH PATTERN RECOGNITION DESKEW 
(PATTERN RECOGNITION OPTION ONLY) 

The Pattern Recognition option allows greater throughput in sequence operation by 
automating the precise setting of deskew points at the beginning of a sequence. 

A pattern recognition deskew site is a unique pattern of wafer features visible within the 
instrument's field of view. The size and shape of the pattern must be uniquely different 
from other wafer features visible in the field of view to ensure that the instrument can 
locate the sites without ambiguity. 

Some examples of good patterns are 

• Alphanumeric characters 

• Circular or rectangular pads that appear singly 

• Crosses 

• Alignment marks 

• Other polygon shapes 

Some examples of bad patterns are 

• Sections of a repetitive grid 

• Circular pads or rectangular pads that repeat in or near the field of view 
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When choosing patterns, keep the following points in mind: 

• Search time depends on pattern size. The larger the pattern, the faster the instrument 
computer can recognize the pattern. Note: Larger patterns require more accurate 
initial positioning within the camera's field of view because the search area is 
reduced. 

Also, you can set the Pattern Recognition options so that the system will perform a 
pattern search if the pattern is not found within the field of view. See Section 8.11, 
''Pattern Recognition Deskew Options," for information. 

• When using rectangular pads, use the entire rectangle. If only two comers are used, 
other rectangles in the field of view could confuse the pattern recognition system. 

• The pattern should be unique and as simple as possible. However, uniqueness cannot 
be sacrificed for simplicity. 

• Choose symmetric patterns. They are less sensitive to image rotation. Circular 
patterns are rotationally symmetric and therefore are good patterns. Similarly, the 
best polygon patterns have the most sides. 

• High contrast features make pattern recognition matches easier. When available, 
choose high contrast features. Noise will not have as much effect on the pattern 
recognition match. The pattern colors are important because the pattern recognition 
system reads the black and white image, not the color image. A pattern with good 
color contrast might not have good black and white contrast. For example, avoid 
yellow-on-white or white-on-yellow patterns, since these color combinations have 
almost zero black and white contrast. 

• Avoid patterns with rough surfaces. By using edge enhancement, the instrument 
computer emphasizes the fine features present on a rough surface. Because rough
ness is random, these features add noise to the system and make the pattern 
recognition system less reliable. 

It is generally a good idea to avoid fixed dust particles in the field of view as well. A void 
selecting wafer-specific defects or features as patterns, or you might confuse the instru
ment computer. This includes dust particles, partially etched areas near the edge of the 
wafer, and so on. 

Semi-Automatic mode allows you to manually adjust the position of the stage in case the 
deskew site does not appear in the field of view when the sequence begins. 

Due to the number of variables that affect pattern recognition, the computer may not always 
be successful in locating a deskew site. You can preset the instrument to do one of four 
things in the event of a failure: 

• continue scanning; 

• stop scanning the wafer and proceed to the next; 

• repeat the pattern recognition; or 

• stop the entire sequence and wait for operator intervention. 
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To set up a sequ~nce with Pattern Rec. Deskew: 

1. In the Sequence Editor window, select Pattern Rec. Deskew from the Mode drop
down box. 

2. Double-click on the DESKEW} entry near the top of the sequence list or highlight 
the DESKEW! entry and click on Teach. The Pattern Rec. Deskew Teach window 
appears and the stylus automatically nulls on the sample surface. 

1-------------'------------;1 Mode, XY 
X; -300 JJa 
Y: -517 )lll 

Z : 53761 JJ• 

0 : 0 . 00 deg 

~ ll:il!!Jil itmrc'ilt1 

Figure 8-16 Pattern Rec. Deskew Teach Window 

3. Choose a pattern to use for pattern recognition. As a rule of thumb, select something 
that is simple and easily recognizable, like an alphanumeric character or an align
ment mark. Something that looks much like another feature that is also within the 
field of view does not work reliably because the wrong site might be identified. 

4. Define a rectangular area that encloses the chosen pattern as follows: 

• Press the left trackball button at one comer of the desired rectangle. 

• Move the trackball toward the opposite comer of the desired rectangle. A blue 
box appears that follows the trackball cursor as it moves. 

• When satisfied with the desired rectangular area, release the trackball button. 

The instrument computer processes the image information defined by the rectangle. 
If the rectangle was too small, a message box appears. Click on the OK button and 
reteach the pattern. 
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5. The blue box remains on the window with a darker blue dot in the center. The stage 
moves until the selected feature is centered in the cross hairs (Fig. 8-17). 

X : 3122 µm 
Y, 3461 µ111 

Z : 54128 )Jm 

0 : 0 . 00 de 

Li'm!l ltilncrell 
Pattern Rec. Match Score= 87.5¾ 

Figure 8-17 Pattern Rec. Deskew Teach Window After Teach 

6. Move the stage a small distance, then click Verify to test whether the system can 
accurately find the feature you have taught. A box is drawn around the feature when 
it is found. If recognition fails, repeat Step 3 and retry. 

7. Click on OK to accept the taught pattern, or click on Cancel to quit the Teach Pattern 
Rec. Deskew window without saving the taught pattern. 

8. Repeat for the DESKEW2 step to establish the second deskew point. 

9. Once the deskew sites have been successfully established, proceed to programming 
the rest of the sequence steps. 

10. Run the sequence. 

8.11 PATTERN RECOGNITION DESKEW OPTIONS 

You can set Pattern Recognition options so that the system performs a pattern search if the 
pattern is not found within the field of view when the sample is positioned at the deskew 
site. This search is called groping. 

The three groping parameters are described below. 
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NUMBER OF GROPING RETRY LAYERS 
This parameter controls how much of the area around the deskew site is searched for the 
pattern. Each layer consists of a square area constructed by evenly surrounding the deskew 
site with squares the size of the camera field of view (Fig. 8-15): 

Groping disabled 
searches only 
camera field of view 

1 Retry Layer 
searches 8 more 
square areas 

Similarly for 3 and 4 Retry Layers (48 and 80 square areas) 

Figure 8-18 Groping Retry Layers 

Available choices are 

• Disabled (the default) 

• 1 (8 Sites) 

• 2 (24 Sites) 

• 3 ( 48 Sites) 

• 4 (80 Sites) 

2 Retry Layers 
searches 24 more 
square areas 

First, the deskew site field of view is searched. If the pattern is not found, the stage moves 
to one comer of the next layer and searches the field of view there. This continues until 
the pattern is found or until all search sites have been examined. If the pattern is still not 
fow1d, the stage moves to one comer of the next layer and continues. 

Note that if it takes 10 s to move the stage, null the stylus, and search one such area, 8 
search sites (I layer ofretry) takes as long as 90 s, 24 sites (2 layers) takes as long as 250 s, 
and so on. 

LOWEST MATCH SCORE 
This parameter allows you to adjust the threshold at which the pattern recognition system 
will conclude that it has found a candidate for the desired deskew site. If the pattern does 
not show up in the original field of view, the search begins, and if any matches score greater 
than the Lowest Match Score, the pattern recognition system concludes that the best of 
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these is the correct site for the deskew site ( unless it finds a match equal to or greater than 
the Maximum Score to Stop Groping). Allowed values range between 20-100%. 

MAXIMUM SCORE TO STOP GROPING 

If the pattern recognition system is groping to find the desired pattern, sometimes the 
matching pattern is found with little ambiguity.Usually a large number such as 90% means 
that the pattern has been found. In this case, there is no reason to continue searching the 
retry layer. If a score equal to or better than the Maximum Score to Stop Groping occurs, 
the searching process stops and the deskew site is placed. 

Allowed values range between 20-100%. If no matches are found that are as good as this 
setting, the search continues until the retry layer areas are all searched, and the best score 
above the Lowest Match Score setting determines the placement of the deskew site. 

To set Pattern Recognition deskew options: 

1. From the main Configuration window (Fig. 5-26), click on the Deskew Options 
button. The Deskew Options dialog box appears (Fig. 8-15). 

2. Edit the fields. 

3. When finished, click on OK to set the options and close the dialog box, or Cancel 
to close the dialog box without changing the previous settings. 

8.12 SEQUENCING WITH THE WAFER HANDLER 

This section discusses sequences using the wafer handler with sequences. The wafer 
handler makes it possible to measure a sequence on as many as 26 individual wafers 
without operator intervention. 
The wafer handler can be configured to load wafers of four different sizes: 

• 100 mm (4 in.) 

• 125 mm (5 in.) 

• 150 mm (6 in.) 

• 200 mm (8 in.) 

The standard system configuration includes one cassette locator for 200-mm wafers. A 
second locator is available as an option. For 100-, 125-, or 150-mm wafers, an additional 
locator plate for each size attaches by thumbscrew on top of the 200-mm locator. 

For satisfactory operation, the handler chuck must be installed (see "Installing a Precision 
Locator" in the Tencor P-20h Long Scan Profiler Reference Manual) and the elevator limit 
properly set (see Section 5.8.4, "Lowest Elevator Position"). 
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Before operating the wafer handler for the first time, read Section 2.7.1, "Protecting the 
Wafer Handler," for important information on protecting the wafer handler and wafer from 
damage. 

NOTE: Cassettes should be the same size and type that Tencor Instru
ments Field Service taught the wafer handler. Cassettes that have 
been used in chemical processing, which causes distortion, can 
make it difficult for the handler to center the wafers on the vacuum 
puck and stage. Dedicated machine cassettes are best. 

Before using the handler, check the following: 

• The vacuum chuck is installed on the stage table. 

• The handler parameters are set up properly. 

• The wafer size is properly set for the aligner. 

The instrument is shipped with the vacuum chuck installed .. 

CAUTION: Do not use a precision locator when using the handler to load 
wafers; you could damage the instrument. 

To set handler parameters: 

1. From the Top Level menu, double-click on Configuration. From the main Config
uration window, click on System Configuration. The Machine Configuration dialog 
box appears: 

Serial Number: 10 

Customer: 1 

1-• I 
Model: P-20 

Machine Type: 

Handler Type: ITencor II 

Figure 8-19 Machine Configuration Dialog Box 
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2. Click on the Handler button. The Handler Setup dialog box appears. 

General Information 

Handler Type:!~ T_en_c_o_r ----~ 

Wafer ID Type: .._IN_o_ne ____ ___..[11 __ 

N1,1mber of Slots: l'-2_5 _____ _,.[!1_: 

Cassette Information 

Place Cassette Name 

t8J Cassette 111 ._I R_E_CE_I_VE_R ____ _, 

t8J Cassette #21 ~ S_E_ND_E_R ____ ~ 

Figure 8-20 Handler Setup Dialog Box 

llllil111tl 
llllllllllll 

3. Edit values as needed. When finished, click on OK to keep the changes, or Cancel 
to close the dialog box and leave the setup in its original state. 

Handler parameters are set up in the Configuration window. Values for the handler 
parameters are set as follows: 

Handler Type 
Handler Type can be either Tencor or None. 

Wafer ID Type 
Wafer ID Type can either be None or OC'R. 

Number of Wafers 
This field identifies the capacity of the wafer cassettes used. The possible choices are 25 
or 26. 

Cassette Information 
These fields specify the number of cassettes used by the handler and how they are used. 
An X in the check box for a cassette indicates that the particular cassette is present on the 
instrument. The Cassette Name fields identify the particular cassette is either the Sender, 
Receiver, or Both. (If only one cassette is available, it must serve as both the receiver and 
the handler.) 
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To set the wafer size on the aligner: 

Turn the wafer size selector dial on the aligner (Fig. 8-21) until it displays the 
appropriate wafer diameter. 

Wafer Size 
Selector Dial -----

Figure 8-21 Setting the Wafer Size Selector 

To prepare for loading wafers using the handler: 

Receiver 
Cassette 
Locator 
(Optional) 

Sender 
Cassette 
Locator 
(Standard) 

1. Place the wafers in the slots of a cassette of the appropriate size. Load the wafer 
right side up. The bottom slot of the cassette is nwnber 1. 

2. Place the cassette on the sender cassette locator (Fig. 8-22) as follows: 

• Tilt the cassette back slightly and place the bottom rear comers of the cassette 
in the grooves on the locator. The grooves are marked with wafer sizes (100 mm, 
125 mm, 150 mm, and 200 mm). 

• Tilt the cassette forward until it fits securely in the grooves of the cassette locator. 
The H-bar across the bottom of the cassette must trip the limit switch in the slot 
on the locator. 
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Figure 8-22 Pla.cing a Cassette on a Locator 

3. If you have two cassette locators, you can use the second one to receive wafers. 

NOTE: Cassettes placed on both locators must be the same ·size. Other
wise, wafers could be damaged and handler performance could be 
affected. Reinitialize the handler each time the cassette size is 
changed. 

4. In the Sequence Editor, click on Handler Options. The following dialog box appears: 

0 Random Selection: 

!RECEIVER 

!RECEIVER 

W 11f 1~r Pw.,li11nm 

!Not Aligned 

II 

0 Operator: 

II-

Figure 8-23 Handler Options Dialog Box 

llalill._l 
I~ 
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The Handler Options include wafer selection settings, cassette selection, and wafer 
prealignment settings. When finished choosing options in this window, click on OK 
to set the options and close the dialog box, or Cancel to close the dialog box without 
changing the previous settings. 

The Handler options are described as follows. 

Wafer Selection Settings 
To select a setting for wafer selection, click on the appropriate radio button. The available 
choices are 

No Automatic 
Load/Unload 

Random Selection 

Selected Slots 

Operator 

The sequence does not automatically load and unload wafers; 
loading and unloading are performed manually. 

A specified number of wafers are randomly selected from the 
cassette. The desired number (1-25 or 1-26) is typed into the text 
box just below the Random Selection radio button. Wafers are 
loaded and unloaded without operator intervention. This can only 
be selected with a full cassette of wafers. 

A specified number of wafers, in specific cassette slots, are loaded 
and unloaded. 

To select or unselect specific wafers, click on the numbers in the 
tall list box to the right of the Selected Slots radio button. You can 
also click on the Select All button to select all 25 wafers, or click 
on the Reset button to clear all selections. 

Similar to Selected except that at the start of the sequence, the 
Handler Options dialog box appears to allow the operator to modify 
the original slot selection before the sequence commences. 

Additionally, the Operator mode allows you to enter Slot ID, Lot 
ID, and Operator ID. Fig. 8-24 shows a 10-slot cassette. 
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10 Slot 10 
9 Slot 9 
8 Slot 8 
7 Slot 7 
6 Slot 6 
5 Slot 5 
4 Slot 4 
3 Slot 3 
2 Slot 2 

Slot 1 

Src. Cass.: l._s_E_N_D_E_R ___ ____.lfil_:: 

Lot ID: 

0 peralor ID:. 

1r,,.·::1&11.EEI 1·-·· 

Tencor P-20h Operations 

Figure 8-24 Select Stage and Slots Screen 

Slot # is the slot identification that the user enters, Lot ID is the cassette name, and the 
Operator ID is any valid user name. This information appears on the Analysis report and 
printouts. 

If Random Selection, Selected Slots, or Operator is chosen, the Handler Options window 
takes on a slightly different appearance (Fig. 8-25). 

0 Random Selection: 

Cauettes 

Load: !RECEIVER 

Unload~ RECEIVER 

Wale, Prealigner 

Mode: lllf'Wl-j\"ij~~ I, .... ~ g.J ..... , .. s., , ~ .......... ..-.----~ 

Angle: lo I 

25 
24 
23 0 Operator: 22 
21 
20 

IFIIIIW1 ~~ 
17 

1~1 ~~ 
14 
13 
12 
11 
lli 
9 
8 
7 
6 
5 
4 
3 
2 
1 

, __ , 
1-1 

Figure 8-25 Handler Options Dialog Box with Slot Selection Enabled 
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When finished, click on OK to set the options and close the dialog box, or Cancel to close 
the dialog box without changing the previous settings. 

Cassettes 
The Cassettes section allows you to select which cassettes to use for loading and unloading 
wafers. The Load and Unload fields have the following possible settings: 

Sender 

Receiver 

Designates the Sender cassette as the wafer source or destination. 

Designates the Receiver cassette as the wafer source or destination. 
Note: The Receiver cassette locator is optional. Instruments without a 
Receiver cassette locator use the Sender cassette locator for both source 
and destination. 

Wafer Prealigner 
The Wafer Prea1igner section contains configuration settings for the handler to prealign 
the wafers before placing them on the handler chuck. 

The Mode field has the following possible settings: 

Flat 

Notch 

None 

Orients the wafer by its major flat. 

Orients the wafer by its alignment notch. 

Turns Wafer Prealignment off. The handler bypasses the aligner when it 
loads wafers .. Bypassing the aligner increases throughput but it can also 
reduce the accuracy of centering the wafer on the stage. 

If the Wafer Prealigner Mode is set to Flat or Notch, the Angle field is active and can 
accept any angle from 0°-360°. The Angle field specifies the position, in degrees, of the 
flat or notch when it is placed on the puck. A value of O causes the wafer to be placed on 
the handler chuck with the flat or notch to the front of the instrument, that is, the 6 o'clock 
position. When a wafer is loaded into a cassette, the flat or notch is rotated 90° and is at 
the 9 o'clock position. 
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t 

GG 
80 
Figure 8-26 Wafer Orientation 

8.13 SAVING AND MAINTAINING SEQUENCES 
Once you have written a sequence that you want to keep for future use, you need to save 
it on the hard disk. 

To save a previously saved sequence: 

Choose Save from the Sequence menu. 
Or click on the Save button in the tool bar. 

To save a new sequence: 

1. Choose Save As from the Sequence menu. The following dialog box appears: 

Figure 8-27 Save Sequence Dialog Box 

2. Type a name for the sequence, then click on OK, or click on Cancel to abort the 
Save operation. 

Sometimes you might want to edit an existing sequence, make a few minor changes, and 
save the result with a new name,. 

To .save a sequence under a new .name: 

1. Choose Save As ... from the Sequence menu. The Save Sequence As dialog box 
(Fig. 8-27) appears. 
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2. Type a name for the sequence. The sequence filename must be a valid DOS filename. 
Valid DOS filenames 

• Can contain a maximum of eight characters 

• Have a three-character extension supplied by the system 

• Are not case-sensitive 

• Can contain only the letters A-Z, the numbers 0-9, and the following special 
characters: tilde(~), exclamation point(!), at sign(@), number sign(#), dollar 
sign ($), percent sign (%), caret ("), ampersand (&), left parenthesis, right 
parenthesis, underscore U, hyphen (-), left brace ( {), right brace (} ), single 
quotation mark('), and apostrophe(') 

• Cannot be identical to the name of another existing sequence or scan recipe 

3. Click on OK, or click on Cancel to abort the Save operation. 

To load a sequence into the Sequence Editor: 

1. In the Sequence Editor window, select Open from the Sequence menu. The following 
dialog box appears (Fig. 8-28): 

INTBUMP 
SCANBARS 
il 
j2 
j3 
lintest 
pl 
peterl 

User: 
Modified: 05/30/94 13: 16: 21 
Comments: 

,., ... 
Fig,ure 8-28 Open Sequence Dialog Box 

2. Select the desired sequence from the 1ist of sequences on the left side. 

3. Click on the OK button. 
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8.14 SAVING AND MAINTAINING SEQUENCE SCAN DATA 
Sequence scan data can be saved for reviewing at a later time. 

To save sequence scan data: 

1. Choose Save Data from the File menu. The following dialog box appears: 

Figure 8-29 Save Data Set Dialog Box 

2. Type a name for the data set, then dick on OK, or click on Cancel to abort the Save 
operation. The data set filename must be a valid DOS filename. Valid DOS filenames 

• Can contain a maximum of eight characters 

• Have a three-character extension supplied by the system 

• Are not case-sensitive 

• Can contain only the letters A-Z, the numbers 0-9, and the following special 
characters: tilde(~), exclamation point(!), at sign(@), number sign(#), dollar 
sign ($), percent sign (%), caret ("), ampersand (&), left parenthesis, right 
parenthesis, underscore U, hyphen (-), left brace ( {), right brace (} ), single 
quotation mark('), and apostrophe(') 

• Cannot be identical to the name ofanother existing data set 

Once a data set has been saved, it is added to the Sequence Data catalog. The Sequence 
Data catalog window allows y0u to select individual data sets for reviewing. You can also 
delete unwanted data sets, 

To view previously saved sequence data: 
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From the Catalog window, click on the Sequence Data button on the left side of the 
screen. The Sequence Data Catalog window appears: 
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Sequence Data: lsEQtST 

Sequence Path: Sequence Sequence No. of Creation Date 
Data Sets 10 Slota 

.., SEQUENCE MISS,WE JEDl 2D 1 ll/21/95 12:35 :12 
t:Jied1eq 

SEQlTRC JED1_2D 1 11/20/95 14 : 21 :54 

Drive: 

1liiil.c: 

~-------
Figure 8-.30 Sequence Data Catalog Window 

To recover unsaved data: 

You can recall to the screen the last data set displayed, including unsaved data, by clicking 
on Recover in the Sequence Data catalog window. 

To review a data set: 

Select the desired data set from the list in the catalog, and click on the Review button, 
or double-click on the desired data set. 

To delete, import, and export sequences, see Chapter 9, "Using the Database." 

8.15 COMBINED SEQUENCE STATISTICS (OPTIONAL) 
You can calculate statistical data from multiple runs of a particular sequence. The computer 
accesses stored data from the data sets you select from the Sequence Data catalog and 
recalculates them. [Reviewers: is there a limit to the number of data sets? Is there other 
pertinent info about this feature?] 
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To obtain combined statistics: 

1. From the Scan Recipe Catalog window, click on Sequence Data. The Sequence Data 
catalog appears. 

2. Holding down CTRL, click on the data sets you would like included in the calculation. 
All must have the same Sequence ID. Those you have chosen will be highlighted. 

A Save Data dialog box appears. 

3. Type a name of the data set and click OK. A statistics summary with the new data 
appears after a short interval. 
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9 USING THE DATABASE 

The Tencor P-20h database allows management of recipes and data. From the Database 
window, you can 

• View the catalogs 

• Delete files 

• Print listings of files (recipe files only) 

• Review recipes or data 

• Export and import files (data files only) 

9.1 DATABASE WINDOW 
To open the Database window, click on the Export/Import icon on the Top Level menu 
(Fig. 3-2). 

The main Database window appears with the Scan Recipe Catalog active. The Database 
window consists of the following elements: 

• Menu bar 

• Tool bar 

• Secondary tool bar with a set of command buttons used to select which of the four 
database catalogs to display 

• Main area of the window, displaying currently selected catalog and a series of 
command buttons 
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S.can Recipe Name: 112000-uro 

Recipe Name Type length Speed Fo,ce Creation Date 
(um) (um/s) [mg) 

130-lOMM 20 333 100 5 11/29/95 14 :37 
lMSCAN 2D 2000 1 5 12/03/95 17 :17 

2M5SCAN 2D 5000 1 5 12/03/95 17 :14 
JOMM-180 2D 500 100 5 11/27/ 95 17 : 33 
JOMM-270 2D 3333 100 5 11/27/95 16 :15 
30MM-90 2D 1000 100 5 11/27/·95 17 :00 
500-180 2D 543 100 5 11/27/95 16 :15 
5MSCAN 2D 10000 1 5 12/03/95 17 :15 
C18-400 20 1000 10 5 11/27/95 16 : 59 
CALIB-13 2D 330 1.00 5 11/27/95 16 :17 
CALIB-26 2D 3331 100 5 11/27/95 16 :18 
CALIB65 2D 667 100 5 11/27/95 16: 18 
J.EDSCAN1 2D 500 100 5 11/29/95 13:22 
JEDSCAN2 2D 1650 100 5 12/01/95 19 : 46 
JEDSCAN3· 2D 1650 100 5 12/03/95 17:45 
MMKGEN 2D 500 100 6 12/01/95 12: 08 

IF~WliiJi:i,%1 ,~ """.,.",;_-_ ... , It..-~. ·, ___ ·=."_;I lllliffie#"...;raei#d .... 01,><1.. . • • _ _ __ Jl!,!J;!!!!.Fs,_ t,;;'W ,,....,.,iffi¥5I 

Figure 9-1 Database Window with Scan Recipe Catalog 

9.1.1 DATABASE WINDOW MENU BAR 
The Database window menu bar provides access to commands and allows easy navigating 
through the four subwindows. 

The Database window menu bar provides the following menus. You can view menus by 
clicking on the titles in the menu bar, or by pressing ALT+ l, where l is the letter that 
appears with an underscore in the desired title in the menu bar. You can choose menu 
items by clicking on a menu entry or by typing the letter that appears with an underscore 
in the desired menu item. Some menu items have hot keys assigned to them. 
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Figure 9-2 File Menu 

Figure 9-3 Edit Menu 

_!:PTransfer 

!!pload 

~ 
Figure 9-4 PPTransfer Menu 

Figure 9-5 Window Menu 

9.1.2 DATABASE WINDOW TOOL BAR 
The Database window tool bar contains a row of icons that resemble buttons. Clicking on 
these icons provides an alternative way to access commonly used functions. 

Each icon suggests the function of the button. For example, the Print button resembles a 
printer. Buttons that appear dimmed are unavailable. 

The Database window tool bar contains the following buttons: 

Button Action 

Deletes the indicated recipe or data set 

Sends the indicated Scan or Sequence recipe to the printer 

Displays the Export dialog box 
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Button Action 

Displays the Import dialog box 

Displays 2D scan data files 

Displays 3D scan data files 

9.1.3 DATABASE WINDOW COMMAND BUTTONS 
You choose which database catalog to maintain by selecting one of the four command 
buttons on the left side of the window. These buttons are visible at all times in the Database 
window and allow you to quickly change catalogs. 

The following command buttons appear: 

Button Action 

Switches the main window to the Scan Recipe catalog 

· Switches the main window to the Sequence Recipe catalog 

Switches the main window to the Scan Data catalog 

Switches the main window to the Sequence Data catalog 

To select a group of parameters to view and edit: 

Click on the appropriate command button, or select the appropriate catalog from the 
Window menu. The right side of the window displays the selected catalog. 

9.2 DELETING DATABASE ITEMS 
You can delete Scan and Sequence recipes and data from the appropriate catalog. 

To delete a database item: 

1. Display the desired catalog by clicking on the appropriate command button on the 
left side of the window. 

2. Select the item you wish to delete by clicking or scrolling with the arrow keys. 

3. Click on the Delete button below the catalog, or the Delete icon in the tool bar. The 
following dialog box appears. 
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Delete Scan Data: STP-HT2? 

Figure 9-6 Delete Recipe Dialog Box 

4. Click on OK to delete, or Cancel to leave the selected item in the catalog. 

9.3 PRINTING DATABASE ITEMS 
You can print a listing of Scan or Sequence recipes from the appropriate catalog. 

To print a Scan or Sequence recipe to the currently active printer: 

1. Display the Scan Recipe or Sequence Recipe catalog by clicking on the appropriate 
command button on the left side of the window. 

2. Select the recipe you wish to print by clicking or scrolling with the arrow keys. 

3. Click on the Print button below the catalog, or the Print button in the tool bar. 

To print a Scan or Sequence recipe to a. selected printer: 

1. Display the Scan Recipe or Sequence Recipe catalog by clicking on the appropriate 
command button on the left side of the window. 

2. Select the recipe you wish to print by clicking or scrolling with the arrow keys. 

3. Select Print from the File menu. The Print dialog box appears. 

4. Select the desired printer from the list box and click on OK. 

For more information on printing, see "Setting Up Printers" in the Tencor P-20h Reference 
Manual. 

9.4 REVIEWING DATABASE ITEMS 
You can select an item in any of the available catalogs to review. This opens the appropriate 
window with the selected item displayed. 

To review a database item: 

1. Display the desired catalog by clicking on the appropriate command button on the 
left side of the window. 

2. Select the item you wish to delete by clicking or scrolling with the arrow keys. 

3. Click on the Review button below the catalog. The appropriate window appears with 
the selected item displayed: 

• From the Scan Recipe catalog: the Recipe Editor 
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• From the Sequence Recipe catalog: the Sequence Editor 

• From the Scan Data catalog: the Data Analysis window 

• From the Sequence Data catalog: the Sequence Data window 

From the Editor windows, you can edit recipes and save the changes before returning to 
the Database window. See Chapter 4, "Recipes,'' and Chapter 8, ''Sequencing,'' for 
information on using the Recipe and Sequence editors. 

9.5 EXPORTING DATA 
You can export Scan or Sequence data to floppy diskettes, or to another directory on the 
instrument computer's hard disk. 

Recipe export is not supported in this release. However, if you have the GEM/SECS 
Option, both data and recipes can be exported by uploading to a host computer. See Section 
10.5, "Downloading Data and Recipes," for more information. 

You can export data in two formats: 

• ASCII format for transferring data to other applications such as spreadsheets, word 
processors, desktop publishing or presentation software 

• Binary format for use on another Tencor P-20h, or for backing up and archiving data 
in its original format 

To export Scan or Sequence Data: 

1. Display the Scan or Sequence Data catalog by clicking on the appropriate command 
button on the left side of the window. 

2. Select the recipe you wish to print by clicking or scrolling with the arrow keys. 

3. Click on the Export button below the catalog, or the Export button in the tool bar. 
The following dialog box appears (Fig. 9-7). 
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Export File 

Drive: I._A _______ _, 

Path: 

Export Type 

0 ASCII 

Figure 9-7 Export Data Dialog Box 

4. In the Drive field, type a if exporting to a floppy diskette, or c if exporting to another 
directory on the hard disk. 

5. In the Path field, type the desired path name, if any. 

6. If a different filename is desired, type it in the Filename field. 

7. Choose whether to export the file in ASCII or Binary form by clicking on the 
corresponding radio button. 

8. Click on OK to export the file, or Cancel to close the dialog box without exporting. 

9.6 IMPORTING DATA 
You can import Scan or Sequence data from floppy diskettes, or from another directory 
on the instrument computer's hard disk .. Data can only be imported in Tencor P-20h binary 
format. 

Recipe import is not supported in this release. However, if you have the GEM/SECS 
Option, recipes can be imported by downloading from a host computer. See Section 10.4, 
"Uploading Recipes," for more information. 

To import Scan or Sequence Data: 

1. Display the Scan or Sequence Data catalog by clicking on the appropriate command 
button on the left side of the window. 

2. Click on the Import button below the catalog, or the Import button in the tool bar. 
The following dialog box appears (Fig. 9-8). 
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micron1.dal 
stp-ht.dal 

if 12:a-a:\ 
~ data 

List Files of !J,pe: Drives: 

._ID_at_a_F_ile_s.c..("_.d_at.;;...) _ __..Ill_.: ._I i:m_a_: ____ ___..I .... : 

Figure 9-8 Open Dialog Box 

Tencor P-20h Operations 

D .!lead Only 

3. On the right side of the dialog box, select the drive from the Drives pull-down list, 
and the directory from the Directories list box. 

4. A list of available files with the extension .DAT appears in the list box beneath the 
File field on the left side of the dialog box. If you want to see a list of files with other 
extensions, select All Files(*.*) from the List Files of Type pull-down list. 

5. Select the desired file, then click on Open. The following dialog box appears: 

Import to File 

Filename: ~1~1_i_il_O_i _____ ~ 

Figure 9-9 Import Data Dialog Box 

6. If you want to rename the file, type the desired name; otherwise, leave the default 
name. 

7. Click OK. The file is imported into the default Scan.or Sequence data subdirectory. 
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10 GEM/SECS OPTION 

The GEM/SECS Option allows the uploading of scan measurement data from the Tencor 
P-20h to a host computer. The capability also supports alarms, data collection, equipment 
states, error messages, initialization, clock, and process program upload and download. 

This chapter describes 

• The GEM/SECS window 

• Enabling SECS communications 

• Checking communication status 

• Configuring GEM parameters 

• Uploading data and recipes 

• Downloading recipes 

For detailed information about the GEM/SECS Option, see the Tencor SECS Interface 
Manual. 

10.1 GEM/SECS WINDOW 
To open the GEM/SECS window, use the Top Level menu (Fig. 3-2). 

To access the GEM/SECS window: 

Click on the GEM+SECS icon in the Top Level menu. The GEM User Interface 
window appears: 

m 

Figure 10-1 GEM User Interface Window 
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10.1.1 GEM/SECS WINDOW MENU BAR 
The GEM User Interface menu bar provides the following menus. You can view menus 
by clicking on the titles in the menu bar, or by pressing ALT+ /, where / is the letter that 
appears with an underscore in the desired title in the menu bar. You can choose menu 
items by clicking on a menu entry or by typing the letter that appears with an underscore 
in the desired menu item. Some menu items have hot keys assigned to them. 

Figure 10-2 GEM File Menu 

10.2 ENABLING SECS COMMUNICATION 

To enable/disable SECS communication: 

Select Enabled from the GEM menu to toggle between states. When communica
tions is enabled, a check appears next to the menu selection. 

To check the GEM status: 
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From any window, the current control state is displayed in the upper right comer of 
the window in the menu bar. For more complete information, double-click on the 
displayed control state, and the following message box appears: 

lilit~ 

Link Stale: I Communicating ::========! 
Control Stale: I Online/Local 

:::::===============: 
Online Subslale: !Local Control ::========! 
Spool Sli!le; I Inactive ~========: 
Prev. Proc. Stale: IINIT ::=========! 
Process Slate: ._IID_L_E ______ ___, 

Figure 10-3 GEM Status Message Box 
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10.3 GEM CONFIGURATION 
GEM parameters can be configured by the operator or host. The GEM Configuration dialog 
box enables configuration of the GEM-related parameters ( configuration, initial states, 
SlF2 message items, optional W-bit use, and host connect retry delay). 

To change the default GEM parameters: 

L From the Top Level menu, double-click on the GEM+SECS button. Select Config ... 
from the GEM menu. The GEM Configuration dialog box appears: 

Communication 

lnil. Comm. Stale: IRlf!I) 

Poll Delay 115 I 
Estab. Comm.. Delay: 120 I 

Spooling 
181 Spooling Enabled 

0 Overwrite Spool 

Max.. Spool Transmit IO :::-====:::: 
Max Spool File Size: 110000 

Equipment Identification 
Model (MDLN): ~iP--2-0 __ _ 

::-=======~ 
Rev. 12.2 

:======~ 
Device Name: I P"20 PROFILE I 

Control Stales--------, 

lnil. Control State: ;::IO=nl=in=e ======:Ill:;·· 

Online Failed Slate: I Equipment Offline I) 

Event Reports 
0 Annotated Reports (S6F13J 

181 W-Bit for S6 

Alarms T ermina1----, 

181 W-Bit for S5 181 W-Bil for S10 

,~ , lllill!l1dl 

Figure 10-4 GEM Defaults Window 

2. Change the parameters as appropriate. When finished, click on the OK button. These 
values are saved to the hard disk so that when the instrument is reset or powered on 
again, these new values are displayed. 

You can also click on Cancel to close the GEM Configuration window without 
changing the parameters. 

10.4 UPLOADING RECIPES 
With the GEM/SECS Option, you can upload ( export) data and recipes to a host computer. 

To upload data and recipes to a host computer: 

1. From the appropriate catalog window, select the recipe or data set you wish to 
upload. 

2. Select Upload from the PPTransfer menu. The following dialog box appears 
(Fig. 10-5). 
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Uploading recipe 14 

Figure 10-5 Upload Dialog Box 

Click on OK to proceed with the upload, or Cancel to abort the operation. 

10.5 DOWNLOADING DATA AND RECIPES 
With the GEM/SECS Option, you can download (import) recipes (but not data) from a 
host computer. 

NOTE: You can import Tencor P-20h data files (in binary format) from floppy 
diskettes. See Section 9.6, "Importing Data," for more information. 

To download recipes from a host computer: 

1. From the Recipe or Sequence catalog, select Download from the PPTransfer menu. 
The following dialog box appears: 

PPld: 

Figure 10-6 PPID Dialog Box 

2. Type the PPID of the recipe that you wish to download, then click on OK to proceed. 
After a few moments, the recipe appears in the list. 
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11 WAFER STRESS APPLICATION OPTION 

11.1 OVERVIEW 
It is important to monitor thin film stress so that thin film stress data can be used to reduce 
process variations. Stress is generated in the film and substrate during thin film deposition. 
The deformation of the thin film can be accommodated by the bending and compressing 
or expanding ( depending on the curvature) of the substrate. 

The Tencor P-20h Wafer Stress application Option enables you to calculate the stress in 
a deposited film by measuring the wafer deflection or curvature that stress induces on the 
substrate. 

The program determines the curvature of the sample by calculating the least square fit of 
the trace data. The equation for stress is as follows: 

1 E t 2 
s 

a= 6R (1 -v) 

where 

E 
( 1 - v) = substrate elastic constant 

ts = substrate thickness 
1f = film thickness 
R = radius of curvature 

The program calculates the radius of curvature by using a least square fitting method. This 
equation assumes that the chord length is much larger than the bow (that is, the wafer 
deflections are smaller compared to its radius of curvature). 

Note: The program results can be verified by using the following equation for the radius of 
curvature (R): 

L2 . 
R = SB' 1fL>>B 

where 

B = bow (maximum between trace and its chord) 
L = chord length (scan length) 

Note: Geometric dimensions are in the same units. 
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The Tencor P-20h program calculates the following stress values: 

• Average Stress derived from the least square fit of the entire profile across the entire 
chord 

• Maximum Stress based on the maximum of n overlapping sections of one-third of 
the length and offset across the wafer, where n is a number selected by the user 

• Center Stress computed at the center third of the profile 

11.2 USING THE WAFER STRESS APPLICATION 
Use the Wafer Stress application to compare pre- and postprocessing traces. This compar
ison calculates the curvature caused solely by the processing-induced stress. For details 
see Section 11.6.1, "Measuring a Difference Stress." 

You also can take a single stress measurement without comparing it to an earlier 
measurement. You may want to take this measurement when you have no prestress data 
for a wafer. For details seeSection 11.6.2, "Measuring a Single Trace Stress."" 

Only the pre- and poststress traces and summaries are saved. Stress values are not saved 
but recalculated each time from the raw traces. To recalculate the stress values, both the 
pre- and poststress traces must be present in the Scan Data catalog. 

11.2.1 ENTERING SCAN IDS 
You enter a name for each scan that you take. You can use any given scan for either the 
pre- or the postscan. 

For example, if you have a two-process step and take three scans, the middle scan is the 
postscan for the first scan, but it is the prescan for the second scan. 

11.2.2 SAVING DATA 
To recompute and display difference measurements, both pre- and poststress raw data 
must be saved. Also, saving the raw and summary data allows you to recalculate the stress 
value with different parameters. 

#271632 Rev. F 1196 

Page 223



Wafer Stress Application Option 11-3 

11.3 THE STRESS WINDOWS APPLICATIONS 
To access Tencor's Wafer Stress application, click on the Stress icon on the Top Level 
Menu of the P-20h Profiler. The Stress Windows Applications screen displays, as shown 
below. 

Sirens Recipe Name: .__II ______ __, 

Stress Recipe Name Date Time 
JOHN 07/23/1995 06 09 10 PM 

07/2311995 06:09:26 PM 

Su str. 

Figure 11-1 Stress Windows Application Screen 

The Stress Windows Application screen provides you with two catalogs of stress recipes 
and scan data. The Stress Recipe Catalog lists the currently available stress recipes saved 
on the hard disk by name and date. The Scan Data Catalog lists the existing scans saved 
on the hard disk by scan ID, stress recipe used, X-, Y-coordinates of the scan, and the date 
and time the scan was taken. 
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11.3.1 STRESS WINDOWS APPLICATION MENU BAR 
The Stress Windows Applications menu bar provides the following menus: 

Figure 11-2 Recipe Menu 

Figure 11-3 Substrate Menu 

Figure 11-4 Vacuum Menu 

Figure 11-5 View Menu 
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Figure 11-6 Stress Menu 

Figure 11-7 Help Menu 

11.3.2 STRESS WINDOWS APPLICATIONS TOOL BAR 
The Stress Windows Application tool bar contains a row of icons that resemble buttons. 
Clicking on these icons provides an alternative way to access commonly used functions. 

Button. Action 

Invokes the Stress Recipe Editor to add a new stress recipe. 

Displays the Print dialog box to print data for the current page. 

Starts a scan using the current recipe. 

Switches to the XY view window. 

Switches to the Theta view window. 

Shortcut key to save changes to the current file. 
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11.4 SELECTING, MODIFYING, AND ADDING A SCAN RECIPE 

To select a recipe: 

Click on the Stress Recipe Catalog of the Stress Windows Application screen. A 
list of available recipes displays in a list box, as shown in Figure 11-8. Select an 
existing receipt from this list. 

Stress Recipe Name: !I ~-----~ 
Stress Recipe Name Dal.e Time 
JOHN 07/23/1995 06 09_10 PM 

07/23/1995 06:09:26 PM 

Substr. 

Figure 11-8 Stress Recipe Catalog 

To modify a recipe: 
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Once you have selected a recipe from the Stress Recipe Catalog, you can edit that 
recipe by selecting the View/Modify button to invoke the Stress Recipe Editor 
screen (Figure 11-2). 
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Stress Recipe 

Stress Recipe Name: JOHN 
S ubst, ate Specification: 

# Stress Points:!~ 1_5 ___ ~ Name: !1.239 Gallium A1seriide lO0 Ill 
Origin Thickness: -! 1_0_00 ____ ~1 um 

x: lo I um Y: ~!o __ ~I um Modulus: 11 -239 I x10A11 Pa 

Scan Pa,amelers 

Scan Length: ._!1_5o_o __ __.l II um Sampling Rate: ! .... 2_00 ____ _.R_-- Hz 

Scan Speed: 1100 IJ um/s Stylus Fo,ce: ,5.0 I mg 

Substr. 

Figure 11-9 Stress Recipe Editor 

To add a n.ew stress .recipe: 

From the Stress Windows Application screen choose the View/Modify button. At 
the Stress Recipe Editor screen click on the New button to start writing the new 
recipe. 

To print a stress recipe: 

Click on the Print button to print the currently selected stress recipe. 

To save a stress recipe: 

To save the currently selected stress recipes, select the Save Stress Recipe menu 
item from the File menu. Use the ESC key to return to the Stress Windows 
Applications screen. The XY button switches to the learning mode. 
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11.4.1 ENTERING STRESS RECIPE VALUES AND PARAMETERS 

There are several fields in the Stress Recipe Editor window that you need to enter to complete 
writing a new recipe. Among these values, you need to ente.r the film thickness and specify 
the substrate for the sample. 

To enter stress parameters: 

1. In the Thickness field, type the thickness (in microns) of the substrate. 

2. In the Substrate Specification field, select a desired substrate with its elastic 
constant. Table 11-1 lists the available substrates and their elastic constants. 

Table 11-1 Elastic Constants for Commonly Used Thin Film Substrates 

Material 

Aluminum 

Aluminum Oxide (Al2O3) 

Aluminum Oxide (Al2O3) 

Aluminum Nitride (AlN) 

Beryllium Oxide (BeO) 

Borophosphosilicate (BPSG) glass 

Gallium Arsenide (GaAs) 

Gallium Arsenide (GaAs) 

Germanium (Ge) 

Germanium (Ge) 

Phosphosilicate (PSG) glass 

Silicon 

Silicon 

Sodalime glass (Comingmicrosheet 021 l) 

* polycrystalline 
+ amorphous 

Orienta- Elastic Constants 
tion (1011 Pa) 

* 1.030 

+ 3.835 

+ 4.895 

+ 4.367 

+ 4.367 

+ 1.500 

111 1.741 

100 1.239 

111 1.837 

100 1.420 

+ 0.988 

111 2.290 

100 1.805 

+ 0.973 

<Other> Allows the user to enter a substrate that does not exist on the list. 

#271632 Rev. F 1196 

Page 229



Wafer Stress Application Option 11-9 

11.5 LOADING AND POSITIONING THE SAMPLE 
For information on loading and positioning the sample, refer to Section 5.2, "Loading a 
Sample," and Section 5.3, "Viewing and Positioning the Sample." Before loading a 
sample, check that it meets the following requirements: 

• The sample has been processed. 

• It was scanned before the processing. 

• The scan is in the database. 

To position the sample to measure stress by comparing pre- and postprocessing traces: 

NOTE: Position the sample exactly as it was positioned for measuring 
stress on a single trace scan. 

1. Use the wafer stress precision locator, which is the locator with the three support 
points. Be sure that you position the sample the same way it was positioned for the 
prestress scan. 

NOTE: If you are using the wafer handler to 'load wafers, make sure the 
wafer stress locator is installed on the stage before starting stress 
measurements. See below for details. See Section 11.5.1, "Tencor 
P-20h Handler Wafer Stress locator." 

The precision locator has fittings that locate wafers of various sizes in X, Y, and 8 
positions. It supports the wafers in a way that minimizes gravitational distortions 
but also ensures that the residual gravitational distortion is the same for both pre
and poststress scans. 

2. You can program the instrument so that the load position moves the stage to exactly 
the right scan position. See Section 5 .2, "Loading a Sample." 

11.5.1 TENCOR P-20H HANDLER WAFER STRESS LOCATOR 
The wafer stress locator (Figure 11-10) is designed to support the wafer during wafer stress 
measurements. The instrument is shipped with the vacuum chuck installed if your 
instrument comes with the wafer handler. To replace the vacuum chuck with the wafer 
stress chuck, use the instructions provided in Section 2.5, ''Installing a Precision Locator," 
in the Tencor P-20h Long Scan Profiler Reference Manual. 
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0 

Figure 11-10 Wafer Stress Locator 

The handler controls the placement of the wafer by centering it on the locator. The three 
wafer support pins can be located for wafers of nominal sizes 3 to 8 in. See Appendix D, 
"Precision Locators," in the Tencor P-20h Long Scan Profiler Reference Manual. 

• If the wafer is loaded using the wafer handler, make sure the wafer is loaded using 
the aligner. Also the angle used for alignment must be the same for the prestress and 
poststress loading. 

• If the sample is loaded manually, note the position of the sample when you load it 
on the stage table. To compare pre- and poststress measurements, you must duplicate 
this scan position for the poststress measurement. 
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11.5.2 TAKING A SCAN 
A single poststress measurement measures the current curvature of the sample. In its 
calculations, the program assumes that the sample was flat before being stressed. 

To take a single, poststress measurement: 

1. Load the sample. 

2. Choose a recipe from the list box ( or create a new recipe). 

3. Position the sample for the scan. 

4. Display either the Stress Windows Applications screen or the Stress Recipe Editor 
screen if you are modifying an already existing recipe or creating a new recipe. 

5. Enter film and substrate information for the sample. 

6. Select START either from the Stress Windows Applications screen or from the Stress 
Recipe Editor screen. 

11.5.3 DISPLAYING A LIST OF SCANS 
Selecting the Scan Data Catalog button of the Stress Windows Application screen displays 
a list of currently existing data scans on the hard disk by scan ID, scan recipe used, X-, 
Y-coordinates of the scan, and the date and time the scan was generated. The Scan Data 
Catalog is shown in Figure 11-11. 

Scan Data Name: 

Scan ID Shen Recipe X Y Date Time Scan 
Qata 

Catalog 

<NONE> ········ -- -- -- /--/ -- -- .--
DAWN 
KATHY 
KWAN1 
KWAN2 

JOHN2 
JOHN 
JOHN 
JOHN 

0 0 
0 0 
0 0 
-14285 -5882 

Figure 11-11 Scan Data Catalog Screen 

07/24/95 12:41 PM 
07/24/95 01:13 PM 
07/23/95 06:12 PM 
07/23/95 06: 13 PM 

Scan Selecl , __ 
<NONE> 

<NONE> 

Analysiis-----,, 

StreH Recipe: 

JOHN 

Substr. 

You can remove a scan from this list simply by se'iecting the scan, then selecting DELETE. 
Pressing ESC while in this screen takes you back to the Stress Windows Application screen. 
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11.5.4 VIEWING SCAN RESULTS 
The Stress application provides you with two ways to access the Scan Results window 
(Figure 11-13) to view a particular scan without performing analysis on the scan. 

Scan ID: PROF2 Streu Recipe Used: JOHN 

25000A 

20500A 

16000A 

11500A 

7000A 

2500A 

-2000A 

-6500A 

-11000A 

-15500A 

-20000A 

• 

0 

~ 
J 

lu 

~ 

--" .J ~ 

150 300 450 600 750 soo 1050 1200 1350 
Scan Lengti, (um) 

Figure 11-12 Scan Results Window 

To view scan results from the Stress Recipe Catalog: 

1400 

Em 

I . Select START from the tool bar to perform a scan, which will be displayed at the 
finish. 

2. Press ESC on the keyboard to return to the Stress Recipe Catalog screen where you 
can start another scan. 

To view scan results from the Scan Data Catalog: 

I. Select the desired scan from the selected a particular scan, select REVIEW to display 
the scan. 

2. Use the ESC key to return to the Scan Data Catalog screen. 
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11.6 ANALYZING THE STRESS RESULTS 
You can calculate both a poststress measurement on a single trace and a difference 
measurement, which compares the poststress data in the current trace with prestress data 
from an earlier scan. 

11.6.1 MEASURING A DIFFERENCE STRESS 
The Stress application enables you to perform analysis on pre- and postprocessing traces. 
To accomplish this, you need to assign a particular scan of your choice that you select 
from the list box as a prestress scan and then select another scan from this list and assign 
that scan as the poststress scan. 

To measure a difference stress: 

1. To assign scans as prescan and postscan, use the Stress Windows Application screen 
(Figure 11-13). 

Scan Data Name: 

Scan Scan ID Streu Recipe X V Dale Time. 

Qata <NONE> --/--/- .. _ . ... 
DA\1/N JOHN2 0 0 07/24/95 12:41 PM Catalog KATHY JOHN 0 0 07/24/95 01 :13 PM 
K\I/AN1 JOHN 0 0 07/23/95 06:12 PM 
K\I/AN2 JOHN -14285 -5882 07/23/95 06:13 PM 
PROF1 JOHN 0 0 07/24/95 01:23 PM 
PROF2 JOHN O O 07/24/95 01·23 PM 

Figure 11-13 Stress Windows Applications 

2. Select the Scan Data Catalog button. 

Scan Select 

l~i\11 
PROF1 I-
PR0F2 

Analysis:---,, 

Slr- Recipe: 

JOHN 

Substr. 

3. Select a scan from the list box or enter a scan name in the Scan Data Name field. 

4. Select SET PRE to assign that scan as a prestress scan. 

5. Similarly, select another scan from the list box. 

6. Select SET POST to assign that scan as the poststress scan. 
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Note: As you make these assignments, notice that the scan ID of the scan you have 
selected appears below the SET PRE and SET POST buttons. 

7. After selecting the two scans, select CALCOLA TE to calculate and view the results 
(Figure 11-14). 

Str~------. 
;;!50QOA. 

Tensile 
Ave: -1.136 e7 MPa 20500A 

Max: -7.703 e7 MPa 
Center: 1.692 e6MPa 

ID lnformatio,.----. 

Pre: PROF1 
Post: PROF2 

Recipe: JOHN 

Substrate: 
1.239 Gallium Arsenide 

Film Thickness: 
1.000 um 

~ Displa,11 Pre-Stress 

~ Displa,11 Post-Stress 

~ Displa,11 Difference 

16000A. 

11500A. 

7000A. 

2500A 

-2000A 

-6500A 

·11000A 

-15500A 

-2000oA. 

Figure 11-14 Stress Results Display 

L___. 

t±:::::: 
T 

r,,- ~ ~ 

0 ·150 300 450 600 750 900 1050 1200 1350 1500 
Sca.n Length(um) 

Subslr. 

11.6.2 MEASURING A SINGLE TRACE STRESS 
In addition to comparing pre- and po~tstress processing traces., you can take a single stress 
measurement without comparing it to an earlier measurement. You may want this mea
surement if you do not have, or choose not to use, prestress data for a wafer. 

To measure a single trace stress: 

1. Select the NONE scan ID from the Scan Data Catalog list box (the first choice in 
the box). 

2. Select CA:hCULA TE on the Scan Data Catalog screen to calculate and view the results 
on the Stress Recipe Display screen. 
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11.6.3 ANALYZING THE RESULTS 
The Stress Results Display (Figure 11-13) lets you display the Prestress, Poststress, and 
Difference deflections. Each of these traces has a corresponding check box labeled Display 
Pre-Stress, Display Post-Stress, and Display Difference. 

The Stress Results Display shows the three traces in three different colors. If you have not 
specified a prestress trace, that line appears as a flat line. 

This screen also displays the results of the calculation (Figure 11-14) as well as the IDs 
of the prestress_and poststress scans and the stress recipe name used. 

NOTE: If you specify two scans by using different scan recipes, the Stress 
application calculates the stress by giving the best estimate over 
the region where data is available for both scans. For regions with 
conflicting sets of data, the program displays a zero stress. 
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12 SIGNAL LIGHT TOWER OPTION 

12.1 OVERVIEW 
A Signal Light Tower is a highly visible indicator of a tool's status. The multi-light device 
can be used to signal that an instrument is in production or to indicate the reason that it is 
not in production . . 
The implementation of the Signal Light Tower Option available in the current release of 
the Tencor P-20h allows you to specify tower responses to specific instrument states. This 
approach involves some relatively simple hardware and new Profiler software that 
translates instrument statues into commands to the new hardware. 

12.2 ACCESSING SIGNAL LIGHT TOWER 
To invoke the Signal Light Tower window, click on the Configuration icon of the Top 
Level menu of the P-20h Profiler software. The Configuration window display appears 
(Figure 12-1). 

Iii 
Iii 
Iii --

Iii 
Iii 
Iii 

System Configuration 

Substrate Configuration 

Data Export Paths 

Teach Handler Load 
Position 

Teach Manual Load 
Position 

Teach Soft Home 
Position 

Teach Lowest Elevator 
Position 

Deskew Options 

Sequence Exe. 0 ption 

Signal Tower 

Change Password 

Handler Load Pos. 

X: 1-98657 I pm 

Y : 1360 I pm 

Theta: 12: I deg 

Elevator: 147693 I pm 

Solt Home Theta : 

Lowest Elevator Position: 

Levelin9 Offset 

Elevator locus speed: 

Figure 12-1 Configuration Window 

Manual Load Pos. 

X: 12521 I pm 

Y: 196638 I 11m 

Theta: ~deg 

Elevator: pm 

16. deg 

155172 pm 

lo arc sec 

110 

Substr. 
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12.2.1 SYSTEM CONFIGURATION 
A check box has been added to the Configuration window, entitled "Signal Tower." When 
this button is pressed, the Signal Light Tower Configuration Editor Utility window appears 
(Figure 12-3). 

Tower Colors: Num. of VoiceS:: Signal Tower Behavior 
13 Colors 11111 Voice II --------------------
Iii Flashing Permitted 

Profiler State: 
GEM Abnormal Unload 
GEM Aborted 
GEM Aborting 
GEM Alarm Paused 

GEM Idle 
GEM Idle with Alarms 
GEM Initialize 
GEM Load 
GEM Measurement Complete 
GEM Measurement Setup 
GEM Measurement Site 
GEM Paused 
GEM Pausing 
GEM Ready 

Figure 12-3 Signal Light Tower Configuration Editor Window 

Select Voice: 
Use Voice tn 

li1:i (Mute on Test! 

Substr. 
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12.2.2 SIGNAL TOWER WINDOWS APPLICATION MENU BAR 
The Signal Tower Windows Applications menu bar provides the following menus: 

Figure 12-3 File Menu 

• Figure 12-4 View Menu 

-Figure 12-5 Options Menu 

Figure 12-6 Help Menu 
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12.2.3 SIGNAL TOWER WINDOWS APPLICATIONS TOOL BAR 
The Signal Tower Windows Application tool bar contains a row of icons that resemble 
buttons. Clicking on these icons provides an alternative way to access commonly used 
functions. 

Button Action 

Load all states. Equivalent to the Reload from Disk button. 

Save the changes to all states. Equivalent to the Save to Disk button. 

Return all states to factory default settings. Equivalent to the Defaults for 
All States button. 

Displays the Print dialog box to print current states and definitions. 

12.2.4 LIGHTING OPTIONS 
The Signal Light Tower allows you to specify any of the five lights: red, yellow, green, 
blue, and white. You can set these lights independently of each other. Lights can be turned 
off, constantly on, or set to flashing. All lights can be turned off or cleared simultaneously. 
The tower displays the proper behavior as appropriate for the settings that are current for 
that Profiler state (Figure 12-3). 

You can edit the tower behavior by using the mouse. If you click on a given light, the light 
toggles its state. This means that if the light was off, it goes to flashing next. If the light 
was flashing, it goes to on next. If the light was flashing, it turns off any other light since 
this control prevents illegal behavior such as two lights being on at the same time. 

To reach the state where all lights are set to off, click on a blank space, away from any 
light or just go to the light that is on and toggle its state until the light is off. 
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12.2.5 LIGHTING EXAMPLES 
The following is a list of examples for lighting corresponding to the instrument states. 

Light 

Red, flashing 

Red, steady 

Yellow, flashing 

Green, flashing 

Green, steady 

Description 

Indicates failure, abort, immediate assistance is required. 

Indicates the equipment is not fully capable. An alarm has 
been acknowledged but not corrected. 

Indicates that the alarm is not acknowledged and needs 
assistance, for example, during unload cassette, comple
tion or run, PM, and so on. 

Indicates the equipment is capable of performing all func
tions but no product is running. 

Indicates that the equipment is fully capable and is running 
wafers. 

12.2.6 VOICE OPTIONS 
The voice custom control is a two-state button (Figure 12-3). It toggles between on and 
off; When voices are permitted and it is in the on state, an appropriate picture shows a 
speaker with sound waves. 

When the voice option is in the off state, another picture shows a speaker without sound 
waves. 

If sounds are not permitted by the current tower, the button shows the alarm clock with a 
red X across it indicating that there is no sound capability. 

The choices for the number of voices are NONE, and 1 through 16. NONE specifies towers 
without sound capabilities. 

12.2. 7 STATUS INFORMATION 
Selected portions of the current status of the P-20h profiler are always available to the 
Signal Light Tower control software. This part of the software informs the user of any 
changes in the status of the instrument at the time the changes occur. 

The list box on the Signal Light Tower window contains a descriptive list (Figure 12-3). 
You can edit the behavior of the signal tower for a particular state by selecting that state 
from the list box. At that point, the current behavior for that state is shown with two custom 
controls, one for the tower voice and one for the tower lights. 

You can test a state after editing it by selecting the Test button. This action immediately 
places the tower into that state so that you can see and hear what the state appears like. 

You can then proceed and edit other states by selecting them from the list box and edit 
them as shown above. 
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Once you have completed editing the behavior of a state, you can select the Save to Disk 
button to save the settings for that state. You can cancel the changes to the states by 
selecting the ESC key and leaving the application without saving to the disk. After you 
have already saved the changes to the states, you can undo the changes by selecting the 
Defaults for All States button that returns all states to factory defaults. 

You are then prompted for a password, if you have set any. If the password that you enter 
is invalid, the changes to the state cannot be saved. 

The system initially starts with Welcome as the password the first time it is run. 

#271632 .Rev, F 1196 

Page 243



Glossary Glossary-1 

GLOSSARY 

2D Data 
Two-dimensional data. 

3D Data 
Three-dimensional data. 

ASCII Data 
ASCII (American Standard Code for Information Exchange) codes are used to represent 
characters for storage in a computer's memory. 

Application 
A software program such as the Tencor P-20h Scan application. 

Application icon 
Graphic symbol representing a software application. The Tencor P-20h Top Level menu 
displays application icons. 

Application window 
The main window opened by an application. 

Area 
See Total Area. 

Area+ 
See Area of Peaks. 

Area-
See Area of Valleys. 

Area of Peaks (Area+) 
Total area bounded by the leveled baseline and the profile above the baseline. 

Area of Valleys (Area-) 
Total area bounded by the leveled baseline and the profile below the baseline .. 
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Arrow keys 
The arrow keys on the operator keypad. These keys can be used to highlight a menu item 
or dialog box option or to move a text or graphics cursor. 

Average Height (Avg) 
The average height of all data points between the measurement cursors relative to the 
leveled baseline. 

Avg 
See Average Height. 

Back up 
To save data from the Tencor P-20h hard disk to diskettes or a network drive (if available). 
The data can be restored at a later time. 

Base 
Used (with prefix Up- or Down-) to identify the bottom of the sloping side of a step, to 
distinguish it from the top of the slope, called the edge. See UpBase, DownBase. 

Bearing Ratio (tp) 
A reference line is drawn parallel to the mean line and at a preselected or predetermined 
distance ( cutting depth) below the highest peak of the roughness trace within the sampling 
length. This reference line intersects the roughness trace in one or more subtended lengths. 
The bearing length is the sum of these subtended lengths. The bearing ratio is the ratio of 
the bearing length to the sampling length. Also called Bearing Length Ratio. 

Centerline 
The center-line divides the profiles such that all areas above it are equal to all areas below it. 

Choose 
To pick a menu item or other item that starts an action. You can choose an item using the 
mouse or keypad. 

Click 
Pressing and releasing the left or right mouse button without moving the mouse. Clicking 
the left button on a menu title, on an icon, on a dialog box option or command button, or 
in a window selects the item. Left and right buttons have different functions when clicking. 
Compare to double-click. 

Concave 
Describes an arc that curves inward from a level reference plane; a valley-like arc. 
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Contact Speed 
Contact speed defines the stylus drop speed at contact with the substrate. 

Convex 
Describes an arc that curves outward from a level reference plane; a hill-like arc. 

Cursor 
An object on the screen that can be moved with the mouse or arrow keys and that allows 
the user to locate or edit data. See limit cursor, particle cursor, and text cursor. 

CutDp 
See Cutting Depth. 

Cutoff Length 
The cutoff length is the wavelength on the filter transmission curve that corresponds to 
75% transmission. According to the ANSI B46.1-1985 standard, 800 µmis the preferred 
cutoff for most surfaces. 

Cutting Depth (CutDp) 
A preselected or predetermined distance below the highest peak of a sample. See Bearing 
Ratio. 

Dq 
See Root-Mean-Square Slope. 

Database 
A collection of data organized by records. The Tencor P-20h database can contain data 
summaries, maps, user IDs, system log records, recipe records, and other data. 

Deskew 
Deskew is a feature of the Tencor P-20h that compensates for any translational or rotational 
errors between different substrates by allowing you to select manually two fixed reference 
points to be used for calculating stage coordinate values. 
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Dialog box 
A rectangular box on the screen that can contain a combination oflists, options, data entry 
fields, and command buttons. A dialog box appears when the instrwnent needs more 
information before performing an operation. 

Disk space 
The total amount of space available on the hard disk. Free disk space is the amount of disk 
space unused. 

Directory 
Computer files are stored on the computer's hard disk in directories. The directory name 
identifies the location where the files are stored. See Path. 

Download 
Importing a recipe from a remote host through the GEM/SECS Option. 

DOS 
Disk Operating System, also called MS-DOS. The central program used to control and 
manage the computer system. 

Double-click 
The mouse action performed when you press and release the mouse button twice in rapid 
succession. The first click selects the item and the second click performs the action 
associated with the item. When you double-click the left button on an application icon, 
the application starts. Left and right buttons have different functions when double-clicking. 
Compare to click. 

DownBase 
The bottom of the sloping side of a trough-like feature, or downward step. 

DownEdge 
The top of the sloping side of a trough-like feature, or downward step. 

Drag 
The mouse action performed when you hold down the mouse button and move the mouse. 
Dragging can be used to choose a menu item and to move a graphics cursor. 

Drive (disk) 
The disk drive identifier. A single character followed by a colon. For examplei C: refers 
to drive C. 
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Edge 
The distance to the first rising or falling edge of a step ( or the apex of a peak) from the 
beginning of the profile. Also used (with prefix Up- or Down-) to identify the top of the 
sloping side of a step, to distinguish it from the bottom of the slope, called the base. See 
UpEdge, DownEdge. 

Export 
To save selected data, such as recipes, wafer summaries, and wafer maps, to diskette. 
Exported data can be imported into another Tencor P-20h system .. See import. 

Field 
A rectangle in a dialog box used for entering data. The text cursor (a vertical bar) generally 
appears in the first field in a dialog box. 

Finite Impulse Response (FIR) 
The Tencor P-20h uses the Finite Impulse Response technique to calculate roughness and 
waviness from digitized data points. 

Form Error 
Form error is a deviation from a perfect realization of a nominally specified shape. For 
example, for a flat surface the form error would be the deviation from flatness. If the 
deviation is periodic (that is, has waves), the error is termed waviness. If there are many 
hundreds or thousands of randomly shaped undulations without a discernible pattern, the 
error is called roughness. The difference between form error, roughness, and waviness is 
not precisely defined; it is more a qualitative distinction. See Waviness and Roughness. 

GEM 
Acronym for Generic Equipment Model. 

Graphics cursor 
Graphics cursors appear as vertical bars in histogram windows and can be used to change 
defect bin splits. 

HSC 
See High Spot Count. 

Height 
The difference in height between two points on the sample surface defined by the positions 
of the measurement cursors. 
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High Spot Count (HSC) 
The number of profile peaks per unit length projecting through a reference line parallel to 
and at a given height above a line drawn through the lowest point of the roughness trace, 
parallel to the mean line. See Peak Count. 

Import 
To load data previously saved in an export file. See export. 

Keylock 
The key lock limits operator access to Scan recipes and Sequence programs for operational 
security. 

Lq 
See Root-Mean-Square Wavelength. 

Locator 
The plate upon which a cassette rests when on the handler. The locator must be changed 
for different cassette sizes. 

Log Off 
Sign off from the Tencor P-20h by choosing the Log Off icon from the To Level menu. 

Manual/Single Scan Mode 
The user programs the parameters for a scan into a recipe using a menu. The scan can be 
specified to be continuous or segmented into sections of equal length. 

Maximum Height (MaxHt) 
The maximum height of a trace relative to the zero line within the sampling length. 

Max Ra 
See Maximum Average Roughness. 

Maximum Average Roughness (Max Ra) 
The trace within the cursors is divided into 19 overlapping sections. Each section is one
tenth of the sampling length. The average roughness (Ra) of each section is calculated and 
the maximum is displayed. 

Maximum Stress 
Maximum stress is the maximum of 13 overlapping sections of one-third the length and 
offset across the total profile. 
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Mean Peak Height (Rpm) 
The mean value of the local peak heights of the roughness trace within the sampling length. 

Mean Peak Spacing (Sm) 
The mean value of the local peak spacing of the roughness trace within the sampling length, 
where the peaks are defined by the criteria of the Peak Count parameter. See Peak Count. 

Menu 
A list of commands. Two types of menus are supported - icon-based menus and drop
down menus. Full-screen menus such as the Top Level Menu display application icons. 
You can start an application by double-clicking the left button on its icon. A menu in the 
menu bar opens when clicked. See menu bar. 

Menu Bar 
Menu bars are displayed at the top of application windows and list menu titles. You can 
open a menu listed in the menu bar by clicking on its title. You can choose from the menu 
by clicking on an item. 

Microsoft Windows 
A graphical user environment developed by Microsoft Corporation that uses windows to 
present information and a pointing device, usually a mouse, for user interaction. 

Minimum Height (Min Ht) 
The minimum height of a trace relative to the zero line within the sampling length. 

Multiscan Average Mode 
A scan is repeated up to ten times and the average is calculated automatically. 

PC 
See Peak Count. 

Parameters 
Measurement attributes such as length, speed, and direction are the parameters used in the 
Tencor P-20h software. 

Path (to file) 
The location of a file or directory. A complete path consists of a drive identifier (A:, for 
example) followed by the directory and subdirectory names. The directory and subdirec
tory names are separated with the backslash character(\). In C:\DATA \ TEMP\ TEST .DAT, 
the path to the TEST.DAT file is C:\DATA\TEMP. 
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Peak 
The distance between the mean line and the highest peak of the roughness trace or waviness 
trace within the sampling length. 

Peak Count (PC) 
The number of peak/valley pairs in the roughness trace per unit len,gth, projecting through 
a band of width b, and centered about the mean line. Projecting through means that the 
profile curve climbs above and then falls below the band. Thus, if the profile rises above 
the band more than once without falling below the band, multiple peaks are not identified. 
See High Spot Count. 

PeakNalley 
The vertical distance between the highest peak and the lowest valley of the roughness or 
waviness trace, leveled on the mean line. Also known as 'Rroax or W max, Maximum Peak
to-Valley Roughness or Waviness. 

Profile Length (Profl) 
The length that would be obtained from drawing out the profile in a straight line within 
the sampling length. 

Profl 
See Profile Length. 

R3z 
See Six-point Height. 

Ra 
See Roughness Average. 

Rh 
See Roughness Height. 

Rp 
See Peak. 

Rq 
See Root-Mean-Square Roughness. 

Rt (PN) 
See PeakN alley. 
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Rv 
See Valley. 

Rz 
See Ten-Point Height. 

RMS 
See Root-Mean-Square. 

Rpm 
See Mean Peak Height. 

RRWG 
Acronym for raw scan, roughness, waviness, and grid. The RRWG colors represent the 
individual color options for the graph and grid lines. 

Radius 
The distance from the center of curvature of the profile arc (assuming a circular profile 
within the sampling length) to the profile. The measurement cursors define two points of 
a circular arc. A least squares fit is performed on the points between the cursors. 

Recipe 
A recipe is a list of scan parameters. 

Recipe ID 
The Recipe ID is the name of the generating recipe. 

Restore 
To return data previously saved by a backup operation. 

Root-Mean-Square Roughness (Rq) 
The root-mean-square or geometric average deviation of the roughness profile from the 
mean line measured in the sampling length. 

Root-Mean-Square (RMS) 
The square root of the arithmetic mean of the squares of a set of numbers. 

Root-Mean-Square Slope (Dq) 
The root-mean-square or geometric average deviation of the slope of the roughness trace. 
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Root-Mean-Square Wavelength (Lq) 

21t times the ratio of the root-mean-square deviation of the profile (Rq) to the root-mean,. 
square slope of the profile (Dq). L is a measure of the spacing of local peaks and local 
valleys, taking into account their rclative amplitudes and individual spatial frequencies. 

Root-Mean-Square Waviness (Wq) 
The root-mean-square or geometric average deviation of the waviness profile from the 
mean line measured in the sampling length. 

Roughness 
A surface is said to be rough when the surface's deviation from flatness has many hundreds 
or thousands ofrandomly shaped undulations. See Form Error and Waviness. 

Roughness Average (Ra) 
The arithmetic average deviation of the absolute values of the roughness profile from the 
mean line or centerline. Also known as Centerline Average Roughness. See Centerline. 

Roughness Height (Rh) 
The difference in height in the roughness profile between the values at the left and right 
cursor positions of the profile. 

SD 
See Std Dev Heights. 

SECS Interface 
The Semiconductor Equipment Controller Standard (SECS) Interface provided on the 
Tencor P-20h defines a computer-to-computer communications interface between the 
Tencor P-20h and a host computer. 

Sm 
See Mean Peak Spacing. 

Sampling Length 
The length of trace between the cursors. 

SECS 
Acronym for Semiconductor Equipment Communication Standard. 
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Segmented Scan 
The scan is divided into segments of equal length and no data is taken between the 
segments.Using this method, roughness can be measured over several short lengths spaced 
equally along a straight line. 

Select 
To highlight an item by clicking it with the mouse or by using the keypad. 

Selection bar 
The highlighted bar or dotted rectangle appearing in a dialog box that indicates the option 
or command button that is selected if you press the ENTER key. The selection bar can be 
moved by using the keypad. 

Sequence 
A program of sequential scans to be performed on a single substrate. 

Sequence Identifier 
The Sequence ID is the name ofthe generating sequence program. 

Six-Point Height {R3z) 
The average height difference between the three highest peaks and the three deepest valleys 
within the cursors measured from a line parallel to the mean line and not crossing the 
profile. 

Slope 
The ratio of the difference in vertical positions to the difference in horizontal positions of 
the measurement cursors. The slope is reported as an angle in degrees. 

Spatial resolution 
Spatial resolution is a measure of a profiler's capability to resolve the smallest vertical or 
horizontal feature on a surface. Four primary factors determine spatial resolution: stylus 
radius, short wave filtering, vertical resolution, and horizontal resolution. In practice, 
stylus radius and short wave filtering are the two factors that limit spatial resolution. 

Std Dev Heights (SD) 
The standard deviation of the local peak heights of the roughness trace about the mean 
peak height within the sampling length. 

StpWt 
See Width of Step. 
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Stylus Force 
The force of the stylus tip when the stylus is in contact with the substrate. 

tp 
See Bearing Ratio. 

TIR 
See Total Indicator Runout. 

Ten-Point Height (Rz) 
The average height difference between the five highest peaks and the five deepest valleys 
within the cursors measured from a line parallel to the mean line. 

Text cursor 
The vertical straight line appearing in fields. The text cursor marks the location where 
characters appear when typed. 

Title bar 
Each application displays a title bar at the top of the application window. The title bar 
shows the application name, current recipe in parentheses, communication mode-Local 
or Remote-and window control buttons. 

Top Level Menu 
The Tencor P-20h Top Level menu displays icons of the applications available to the user. 

Total Indicator Runout (TIR) 
The difference in height between the highest and the lowest points within the surface 
bracketed by the cursors. 

Type 
Type identifies the type of data that can be saved, recalled, restored, or deleted in a 
sequence. The following six preset values are available: raw trace data, point data, 
sequence results, 3D data, and any data. Statistics data is supplied within sequence results. 

UpBase 
The bottom of the sloping side of a step-like feature, or upward step. 

UpEdge 
The top of the sloping side of a step-like feature, or upward step. 
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Upload 
Exporting a recipe or data set to a remote host through the GEM/SECS Option. 

Valley 
The distance between the mean line and the lowest valley of the roughness or waviness 
trace within the sampling length. 

Wa 
See Waviness Average. 

Wh 
See Waviness Height. 

WP 
See Peak. 

Wq 
See Root-Mean-Square Waviness. 

Wt 
See Peak.IV alley. 

Wv 
See Valley. 

Waviness 
Waviness of a surface is a periodic deviation from flatness, where the wavelengths 
generally range from 30 to more than 100 times the average wavelength of the roughness. 
See Form Error and Roughness. 

Waviness Average (Wa) 
The arithmetic average deviation of the absolute values of the waviness profile from the 
mean line or centerline. Also known as Centerline Average Waviness. See Centerline. 

Waviness Height (Wh) 
The difference in height in the waviness profile between the values at the leH and right 
cursor positions of the profile. 

Width of Step (StpWt) 
The distance between the first rising edge and the next falling edge of a step height plateau. 
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Window 
Rectangular area for displaying and running an application program. The Scan application 
displays the Scan window. 
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Numerics 
3-D data 

analysis 7-1 
view options 7- l 

3-D data measurement 
average height 7-12 
data leveling 7-11 
step height 7-12 

3-D image manipulation 
setting proportions 7-4 
shading mode 7-1, 7-5 
view selection 7-3 
x and y granularity 7-5 

3-D scans 
cursors 4-20 

A 
Adjusting optical magnification 5-15 
Alignment options 5-11 
Analysis report, information 8-32 
Arc correction 2-27 
Area- (Area of Valleys), recipe parameter 4-23 
Area (Total Area), recipe parameter 4-23 
Area+ (Area of Peaks), recipe parameter 4-23 
Arrow keys 1-8 
Auxiliary panel controls 2-5 

Emergency off option 2-5 
Available scan speeds 4-10 
Average (Ra), recipe parameter 4-24 
Average (Wa), recipe parameter 4-26 
Average stress 11-2 
Avg (Average Height), recipe parameter 4-22 

B 
Base angle in sequence 8-18 
Bearing ratio, recipe parameter 4-28 
Boot, definition of 1-8 

C 
Cassettes, wafer 

Handler issues 5-7, 8-27 
Placing on cassette locator 5-10, 8-29 

Caution boxes 1-7 
Center stress 11-2 
Check boxes 2-14 
Checking GEM status, GEM/SECS Option 10-2 
Chuck, vacuum 2-23 
Combined Sequence Statistics Option 1-6, 8-37 
Command buttons 2-13 
Command, definition of 1-8 

Configuration window 
Signal light tower 121 

Configuration, GEM/SECS Option 10~3 
Contact speed, recipe parameter 4-12 
Conventions 

Terminology 1-8 
Typographic formatting 1-7 

Coordinate system 3-6, 5-13 
Cursor, definition of 1-8 
Cursors 

Delta 6-8 
Measurement, 2-D 6-4 
Saving current positions in recipe 6-7 

Cutoff filters, using 6-15 
Cutting depth, recipe parameter 4-28 

D 
Data analysis window 

Parts of 6-1 
Data analysis window, 2-D 

Cursors 6-4 
Leveling 6-4 
Menu bar 6-2 
Surface parameter summary window 6-1 
Tool bar 6-4 
Trace window 6-1 

Data analysis window, 3-D 7-1 
Graphics tools 7-4 
menu bar 7-2 
tool bar 7-3 

Data entry fields 2-16 
Data point interval, recipe parameter 4-11 
Data points, recipe parameter 4-11 
Database 

Deleting items 9-4 
Exporting 9-6 
Importing 9-7 
Printing 9-5 
Reviewing items 9-5 

Database manager feature 1-5 
Database menu 9-1 
Database window 

Command buttons 9-4 
Menu bar 9-2 
Tool bar 9-3 

Database, definition of 1-9 
Deleting items from database 9-4 
Dialog boxes 2-12 
Directory, definition of 1-9 

lndex-15 

Distance to Edge (Edge), recipe parameter 4-23 
Distance to edge, feature detection 6-13 
Double-click, definition of 1-9 
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Downloading from host, GEM/SECS Option 10-4 
Drag, definition of 1-9 
Drop-down lists 2-17 

E 
Edge, feature detection 6-13 
Enabling/disabling communication., GEM/SECS Option 

10-2 
Exporting data from database 9-6 

F 
Feature 

Feature detection 6-10 
Recipe parameter 4-14 

Feature detection 4-13, 6-9 
Feature number 

Feature detection 6-11 
Recipe parameter 4-14 

Field 1-9 
Field, definition of 1-7 
Filters, long wave cutoff 6-17 
Filters, long wave cuttoff 

RC and Gaussian 6-17 
Filters, short wave cutoff 6-17 
Fine Movement Mode 6-7 
Fit and level 6-26 
Fit and level, recipe parameter 4-20 
Fitting curved profiles 6-26 
Forms 2-12 

G 
Gaussian filter 6-17 
ge 8-32 
GEM/SECS Option 

Changing parameters 10-3 
Checking status 10-2 
Configuration 10-3 
Downloading from host 10-4 
Enabling/disabling communication 10-2 
Menu bar 10-2 
Uploading to host 10-3 
User Interface window 10-1 

Getting started tutorial 
Aborting a scan 3-9 
Lowering the measurement head 3-6 
Measurement cursors 3-10 
Positioning in X and Y 3-6 
Printing data 3-10 
Reading data 3-10 
Saving data 3-10 
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Selecting the recipe 3-3 
Starting up the system 3- 1 
Taking a scan 3-8 
Unloading the sample 3-11 
Viewing and positioning the sample 3-5 
XY View window 3-4 

Granularity 7-5 
Granularity, 3-D image 7-5 

H 
Handler chuck, vacuum valve settings 2-24 
Handler options, sequencing 

Cassettes 8-33 
Wafer prealigner 8-33 
Wafer selection settings 8-31 

Handler parameters 
Cassette information 5-9, 8-28 
Handler type 5-9, 8-28 
Number of wafers 5-9, 8-28 
Wafer ID type 5-9, 8-28 

Handler vacuum chuck 2-23 
Handler, wafer 

Basics 2-22 
Loading single wafers 5-10 
Loading wafers 8-29 
Protecting 2-22 
Resetting 2-23 
Setting parameters 5-9, 8-28 
Vacuum chuck 2-23 
Vacuum puck 5-7, 8-27 
Wafer sizes 5-7, 8-26 

Height l0pt (Rz), recipe parameter 4-25 
Height 6pt (R3z), recipe parameter 4-25 
Help 2-28 
High spot count, recipe parameter 4-30 
Highlight, definition of 1-9 

Importing data from database 9-7 
Individual trace, recipe parameter 4-11 
Instrument components 2-1 
Instrument controls 2-1 

K 
Keyboard 

Figure 2-1 
Keys, description of action 2-2 
Trackball 2-4 

Keyboard, definition of 1-9 
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L 
Left level, recipe parameter 4-20 
Left measurement, recipe parameter 4-20 
Leveling 

2-D Scan data 6-4 
X Start 7-13 

Leveling cursors 
Xl andX2 4-19 

Leveling cursors, 2-D 
In recipe 4-19 

Leveling cursors, 3-D 4-20 
Leveling, 3-D scan data 7-11 
List boxes 

Using 2-15 
Loading 

Handler parameters 5-9, 8-28 
Single wafer with handler 5-10 
Wafers with handler 8-29 

Loading samples 
With handler 5-7 
Without handler 5-6 

Long wavelength cutoff 
Available settings 4-19 
In recipe 4-18 

Lot ID 8-31 

M 
Maintaining 

Recipes 4-31 
Sequences 8-34 

Maximum Ra (Max Ra), recipe parameter 4-24 
Maximum stress 11-2 
Mean Peak Height (Rpm), recipe parameter 4-25 
Mean peak spacing (HSC), recipe parameter 4-30 
Mean peak spacing (PC), recipe parameter 4-31 
Measurement cursors 

In recipe 4-19 
XI and X2 4-19 

Menu, definition of 1-10 
Menus 

Drop-down 2-12 
Icon-based 2-12 

Message box 2~ 12 
MicroHead 

Electrostatic effects 5-24 
Importance of mechanical leveling 5-22 
Scanning at low stylus forces 5-20 

Minimizing windows 2-20 
Minimum plateau width, feature detection 6-12 
Minimum plateau width, recipe paramete.r 4-15 
Miscellaneous controls 2-7 
Moveable windows 2-19 

multiple analysis 8-13 

N 
Noise filter, recipe parameter 4-15 
Note boxes 1-7 

0 
Operator ID 8-31 
Operator mode 

p 

Lot ID 8-31 
Operator ID 8-31 

Pattern recognition 
Choosing good patterns 8-21 
Deskew 8-21 
Sequence 8-23 

Pattern recognition deskew options 
Lowest match score 8-25 
Max. score to stop groping 8-26 
No. of groping retry layers 8-25 

Peak (Rp), recipe parameter 4-25 
Peak (Wp), recipe parameter 4-26 
Peak count, recipe parameter 4-30 
Peak:Nalley (Rt), recipe parameter 4-25 
Peak:Nalley (Wt), recipe parameter 4-26 
Plateau threshold, recipe parameter 4-14 
Plateau/apex threshold, feature detection 6-11 
Powering down the instrument 2-28 
Powering up the instrument 2-7, 3-1 
Printing recipes from database 9-5 
Profile type, recipe parameter 4-12 
Profile, definition of 1-10 
ProtL (Profile Length), recipe parameter 4-23 
Prompt, defmition of 1-10 

R 
Rad (Radius), recipe parameter 4-23 
Radio buttons 2-15 
RC filter 6-17 
Reboot, definition of 1-10 
Recipe 

Definition of 1-10 
Selecting current 3-3 
Selecting for sequence 8-6 

Recipe editor window 
Bearing ratio/cutting depth 4-27 
Feature detection 4-13 
Filters/cursors 4-15 
General parameters 4-21 

lndex-17 
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High spot count/peak count 4-28 
Menu bar 4-5 
Parts of 4-4 
Roughness/waviness 4-24 
Scan parameter definitions 4-9 
Tool bar4-7, 9-3 

Recipe parameters 
Area of peaks (Area+) 4-23 
Area of valleys (Area-) 4-23 
Average (Ra) 4-24 
Average (Wa) 4-26 
Average height (Avg) 4-22 
Bearing ratio 4-28 
Contact speed 4-12 
Cutting depth 4-28 
Data point interval 4-11 
Data points 4-11 
Distance to Edge (Edge) 4-23 
Feature 4-14 
Feature number 4-14 
Filter Option 4-15 
Fit and level 4-20 
Height lOpt (Rz) 4-25 
Height 6pt (R3z) 4-25 
High spot count 4-30 
Left level 4-20 
Left measurement 4-20 
Maximum Ra (Max Ra) 4-24 
Mean peak height (Rpm) 4-25 
Mean peak spacing (HSC) 4-30 
Mean peak spacing (PC) 4-31 
Minimum plateau width 4-15 
Noise filter (short wavelength cutoff) 4-15 
Peak (Rp) 4-25 
Peak (Wp) 4-26 
Peak count 4-30 
Peak/valley (Rt) 4-25 
Peak/valley (Wt) 4-26 
Plateau threshold 4-14 
Profile length (ProfL) 4-23 
Profile type 4-12 
Radius (Rad) 4-23 
Right level 4-20 
Right measurement 4-20 
RMS (Rq) 4-24 
RMS (Wq) 4-26 
RMS slope (Dq) 4-25 
RMS wavelength (Lg) 4-26 
Roughness height (Rh) 4-25 
Scan direction 4-11 
Scan length 4-10 
Scan speed 4-10 
Slope 4-22 
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Slope threshold 4-14 
spacing 4-11 
Step height 4-22 
Step width (StpWt) 4-23 
Stylus force 4-11 
Total area (Area) 4-23 
Total indicator runout (TIR) 4-22 
Total time 4-11 
traces 4-11 
Valley (Rv) 4-25 
Valley (Wv) 4-26 
Waviness filter (long wavelength cutoff) 4-18 
Waviness height (Wh) 4-26 

Recover 8-37 
Resetting the instrument 2-7, 2-28, 3-1 
Resizeable windows 2-19 
Resizing windows 2-20 
Reviewing items from database 9-5 
Right level, recipe parameter 4-20 
Right measurement, recipe parameter 4-20 
RMS (Rq), recipe parameter 4-24 
RMS (Wq), recipe parameter 4-26 
RMS Slope (Dq), recipe parameter 4-25 
RMS Wavelength (Lq), recipe parameter 4-26 
Roughness Height (Rh), recipe parameter 4-25 

s 
Sample surface, possible damage to 4-12, 11-15 
Saving 11-2 

Recipes 4-31 
Sequences 8-34 

Scan application window 3-3 
Scan direction, recipe parameter 4-11 
Scan length, recipe parameter 4-10 
Scan speed, recipe parameter 4-10 
Scan, definition of 1-10 
Screen, definition of 1-10 
Scroll bars 2-17 
SECS 

See GEM/SECS Option I 0-1 
Section 6-4 
Section 5.7.2, "Leveling the Stage." 6-4 
Select Stage and Slots screen 8-31 
SEMI standard M20-92, wafer coord. system 3-6, 5-13 
Sequence 

Base angle 8-18 
Capabilities 8-1 
Deskewing twice to align theta 8-20 
Groping (pattern recognition) 8-24 
Manual deskew 8-18 
Mode 8-7 
Pattern rec. deskew 8-21 
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Pattern recognition deskew options 8-24 
Running 8-10 
Saving and maintaining 8-34 
Saving scan data 8-36 
Searching for pattern (groping) 8-24 
Semi-automatic mode 8-7 
With handler 8-26 
Writing 8-9 

Sequence Editor window 
Data options 8-7 
Handler options 8-9 
Options 8-6 
Recipe catalog 8-6 
Sequence Information dialog box 8-5 
Sort options 8-9 
Tool bar 8-5 

Sequence editor window 
Menu bar 8-4 
Parts of 8-3 

Sequence Parameter Data window 8-15 
Sequence, definition of 1-11 
Sequencing 

wafer summary 8-15 
Setting 2-D cursors 6-7 
Setting 3-D image proportions 7-4 
Short wavelength cutoff 

Available settings 4-18 
Setting in recipe 4-15 

Shutting down the instrument 2-28 
Signal light tower 121 

Accessing 121 
Configuration window 122 
Lighting examples 125 
Lighting options 124 
Menu bar 123 
Status 125 
Voice options 125 

Signal tower windows application 123 
Signal tower windows application screen 

Menu bar 123 
Tool bar 124 

Slope threshold 
Feature detection 6-11 
Recipe parameter 4-14 

Slope, recipe parameter 4-22 
Slot ID 8-31 
Software features 

Automatic sequencing 1-5 
Database manager 1-5 

Sress scan recipe 
Entering parameters 11-8 

Stage 
Configuration 5-27 

Leveling 5-25 
Std, dev. height, recipe parameter 4-26 
Step height, recipe parameter 4-22 
Step width (StpWt) 

Feature detection 6-13 
Recipe parameter 4-23 

Stress 
Adding a scan recipe 11-6 
Analyzing the results 11-15 
Average 11-2 
Center 11-2 
Entering an ID 11-2 
Entering scan parameters 11-8 
Equation 11-1 
List of scan data 11-8 
Maximum 11-2 
Measuring a difference trace 11-2 
Measuring a single trace 11-2, 11-14 
Modifying a scan recipe 11-6 
Saving data 11-2 
Selecting a scan recipe 11-6 

lndex-19 

Stress Windows Application screen 11-3 
Taking a single, post-stress measurement 11-11 
Thin film 11-1 

Stress chuck 11-9 
Stress scan recipe 

Adding 11-6 
Modifying 11-6 
Selecting 11-6 

Stress Windows Application 11-3 
Menu bar 11-4 

Stylus 
Possible damage to 2-24, 2-26 
Protecting 2-25 

Stylus arm assembly 
Possible damage to 2-26 
Protecting 2-25 

Stylus error 
Arc correction 2-27 

Stylus force, recipe parameter 4-11 

T 
Terminology 1-8 
Thin film stress 11-1 
Total indicator runout (TIR), recipe parameter 4-22 
Total time, recipe parameter 4-11 
Trace, definition of 1-11 
Trackball 2-4 
Trackball cursor 2-4 
Turning off the instrument 2-28 
Tutorial 

Getting started 3-1 

#271632 Rev. F 1196 

Page 262



lndex-20 

Simple sequence 8-10 
Typographic formatting 1-7 

u 
Unloading sample 

With handler 5-25 
Without handler 5-25 

Uploading to host, GEM/SECS Option 10-3 

V 
Vacuum chuck 2-23 

Lowest elevator position and 2-24 
Older model valve settings 2-25 
Valve settings 2-24 

Vacuum puck, wafer handler 5-7, 8-27 
Valley (Rv), recipe parameter 4-25 
Valley (Wv), recipe parameter 4-26 

w 
Wafer handler 

Basics 2-22 
Loading single wafers 5-10 
Loading wafers 8-29 
Protecting 2-22 
Resetting 2-23 
Setting parameters 5-9, 8-28 
Vacuum chuck 2-23 
Vacuum puck 5-7, 8-27 
Wafer sizes 8-26 

Wafer ID 8-31 
Wafer Summary 8-15 
Wafers 

Angular orientation in handler 5-11 
Cassettes 5-7, 8-27 
Possible damage to 5-11 
Sizes for handler 5-7, 8-26 

Waviness filter, recipe parameter 4-18 
Waviness height (Wh), recipe parameter 4-26 
Width of step (StpWt) 6-13 
Window, definition of 1-11 
Windows elements 

Check boxes 2-14 
Command buttons 2-11, 2-13 
Control menu 2-10 
Data entry fields 2-16 
Drop-down lists 2-17 
Forms 2-11, 2-12 
Help system 2-28 
List boxes 2-15 
Menu bar 2-10 
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Message box 2-12 
Radio buttons 2-15 
Scroll bars 2-17 
Title Bar 2-10 
Tool bar 2-11 

Windows, working with 2-9 

X 
X and Y granularity 7-5 
X Start leveling 7-13 
XY view window 

z 

Menu bar 5-3 
Parts of 5-1 
Tool bar 5-5 

Zoom 
See optical magnification 5-15 · 
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